This free e-Book will teach you Excel 2019 for Mac in five hours.

We've helped over 2 million students to learn Excel. If you carefully work through this free book there is
absolutely no doubt that you will master Excel 2019 for Mac fundamentals.

Make sure you are using the correct version of this free e-book. A free
e-book is available for all commonly used Excel versions.

We continuously update our free and published books based upon user feedback so that the latest version
has no known errors. You can download the most recent version of this free e-book from:
https://thesmartmethod.com. This book is only for Excel 2019 (or 365) for Apple Mac. We also produce a
version of this free e-book for Excel 2016 for Mac and for the Excel Windows versions: 2007, 2010, 2013, 2016,
2019 and 365. You can download any of these versions from: https://thesmartmethod.com.

Why you should use this free e-book

B [tis free (and you can print it). Because this book is free of charge, schools, colleges, universities and
businesses are able teach their students best-practice Excel skills without the substantial cost of
designing lesson plans or purchasing books. If printed copies are needed you can print them yourself,
or any copy shop can print books for you.

B ]t is written entirely for the Apple Mac version of Excel 2019. While this book covers the same material
as our acclaimed Excel 2019 for Windows course, the book has been completely re-written for the (very
different) Apple Mac version.

B Smart Method® books are #1 best sellers. Every paper printed Smart Method®Excel book (and there
have been ten of them starting with Excel 2007) has been an Amazon #1 best seller in its category. This
provides you with the confidence that you are using a best-of-breed resource to learn Excel.

B Learning success is guaranteed. For over fifteen years, Smart Method® courses have been used by large
corporations, government departments and the armed forces to train their employees. This book has
been constantly refined (during hundreds of classroom courses) by observing which skills students find
difficult to understand and then developing simpler ways of explaining them. We have never had a
student who has failed to learn Excel after taking one of our courses.

B Itis the book of choice for teachers. As well as catering for those wishing to learn Excel by self-study,
Smart Method® books have long been the preferred choice for Excel teachers as they are designed to
teach Excel and not as reference books. Books follow best-practice adult teaching methodology with
clearly defined objectives for each learning session and an exercise to confirm skills transfer. With single,
self-contained lessons, the books cater for any teaching or self-learning period (from minutes to hours).

B No previous exposure to Excel is assumed. You will repeatedly hear the same criticism of most Excel
books: “you have to already know Excel to understand the book”. This book is different. If you’ve never
seen Excel before, and your only computer skill is using a web browser, you'll have absolutely no
problems working through the lessons.

B It focuses upon the everyday Excel skills used in the workplace. This free Basic Skills book will teach
you the basics without confusing you with more advanced, less used, Excel features. If you decide to
expand your Excel education, you’ll be able to move on to other Smart Method® books (or e-books) in
this series to master even the most advanced Excel features.

B It provides a clearly defined route to become a true Excel guru. If you later decide that you'd like to
become a true Excel guru, we also have Essential Skills and Expert Skills books in this series that will teach
you very advanced features that very few Excel users (even top professionals) really understand.



Learn Excel in just a few minutes each day (or in one five-hour sitting)

Excel is a huge and daunting application and you'll need to invest some time in learning the skills presented
in this book. This will be time well spent as you’ll have a hugely marketable skill for life. With 1.2 billion
users worldwide, it is hard to imagine any non-manual occupation today that doesn’t require Excel skills.

This book makes it easy to learn at your own pace because of its unique presentational style. The book
contains 43 simple, self-contained lessons and each lesson only takes a few minutes to complete.

You can complete as many, or as few, lessons as you have the time and energy for each day. Many learners
have developed Excel skills by setting aside just a few minutes each day to complete a single lesson. Others
have worked through the entire book in less than five hours.

Hardly anybody understands how to use every Excel feature

It is important to realize that Excel is probably the largest and most complex software application ever
created. Hardly anybody understands how to use every Excel feature, and, for almost all business users, large
parts of Excel’s functionality wouldn’t even be useful.

Many learners make the fundamental error of trying to learn from an Excel reference book that attempts to
document (though not teach) everything that Excel can do. Of course, no single book could ever actually do
this. (There are some advanced Excel features that easily justify an entire book of their own).

This free Basic Skills book will teach you the fundamental Excel skills that are used every day, in offices all
over the world. The book’s objective is to teach the basics without confusing you by including more
advanced, less used, Excel features.

By the end of this free Basic Skills book you'll be completely comfortable creating your own formulas using
functions from Excel’s vast function library. You'll also have mastered fundamental Excel skills such as
AutoSum, AutoFill and Formula Autocomplete. You'll be confident in the knowledge that you are using Excel’s
features in the correct, best-practice, professional way and you'll feel really at home with Excel.

If you decide to expand your Excel education, you’ll be able to use other books in this series to master even
the most advanced Excel features.
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If you'd like to review the precise skills taught in each book you can view the full course outlines for
Essential Skills and Expert Skills at: https://thesmartmethod.com.




Excel competence levels

Office workers who use Excel every day for a living generally only use (and only need) a tiny fraction of
Excel's enormous feature set.

Excel is a huge application with thousands of features. For most users it is a mistake to attempt to learn
every Excel feature but, instead, to learn Excel to a competence level that is appropriate for your needs.

Essential

Basic Skills

This is where you will be at the end of this book. You'll feel really comfortable with Excel. Even at Basic
Skills level you'll have mastered many skills that most untrained Excel users are unable to use correctly.
You'll also be using the correct professional techniques rather than “muddling though” in the way that most
self-taught Excel users do. You'll be able to create your own formulas using functions from Excel’s vast
function library and have a complete mastery of fundamental Excel features such as AutoFill.

Essential Skills

At this level you will have excellent Excel skills, good enough to impress any employer, and your Excel skills
will be better than most office workers (even those with many years of experience). You'll be able to create
beautifully laid-out worksheets that will really impress. You'll also have mastered many advanced features
that few Excel users understand such as absolute and relative cell references, visualizations, advanced charts,
conditional formatting, date serial numbers, themes and cloud computing. You can see a full list of the lessons in
the Essential Skills course at our web site: https://TheSmartMethod.com.

Expert Skills

At Essential Skills level you'll be really, really good with Excel. If you want to join the tiny elite of power-
users who can do absolutely everything with Excel you can move to expert level and become a true Excel
guru.

This is a extremely high level of Excel competence that is very rarely found in the workplace (even amongst
top professionals). Your Excel skills will be greater and broader than almost all other Excel users and you
will understand (and be able to use) absolutely every Excel feature. You'll have a complete mastery of skills
that are often even a mystery to Excel power users such as Pivot Tables, what-if analysis, validations, solver,
macros and slicers. You can see a full list of the lessons in the Expert Skills course at our web site:
https://TheSmartMethod.com.




Every lesson is presented on two facing pages

Pray this day, on one side of one sheet of paper, explain how the Royal Navy is prepared to meet the
coming conflict.
Winston Churchill, Letter to the Admiralty, Sep 1, 1939

Winston Churchill was aware of the power of brevity. The discipline of condensing thoughts into one side of
a single sheet of A4 paper resulted in the efficient transfer of information.

A tenet of our teaching system is that every lesson is presented on two facing sheets of A4. We’ve had to
double Churchill’s rule as they didn’t have to contend with screenshots in 1939! If we can’t teach an essential
concept in two pages of A4 we know that the subject matter needs to be broken into two smaller lessons.

How this book avoids wasting your time

Over the years | have read many hundreds of computer text books and most of my time was wasted. The big
problem with most books is that I must wade through thousands of words just to learn one important
technique. If I don’t read everything I might miss that one essential insight.

Many presentational methods have been used in this book to help you to avoid reading about things you
already know how to do, or things that are of little interest to you.

Excel 2019 has many new features that Leam Excel 2019 for Mac OS X Expert Skills with The Smart Methad
won'’t be available to users of older
. Lesson 3-28: Use the IFS
Excel versions. note f p
All of Excel 2019’s new features are N The IES function is unction
Clearly documented. \ new in Excel 2019 In: Lesson 3-22: Use a VLOOKUP function for an exact lookup, you used a
\[FSis anew on for Excel VLOOKUP function to return a grade from different pass mark
2019, 50 it will not be available percentages.
to users of earlier Excel Microsoft have added a new IFS function to Excel 2019. In this lesson you
S h . d d . 1 . h TS, will solve exactly the same problem posed in: Lesson 3-22; Use a
creens OtS are PrOVI ed mn-line WIt You should avoid using IFS if VLOOKUP function for an exact lookup, with a logic based (rather than
the text when they can explain what yous workdooks need to be lookup based) solution.
~
you need to do more Clearly than ™~ versions of Excel. 1 Open IFS Grades-1 from your sample files folder.
words alone. A e < |ol.® ;
1 |[Exam Results
2
note 3 |Name Percentage  Grade Percentage  Grade
4 Johnny Caine 70% 0% Fail
If you want to progress through the VLOOKUP is still 5 |George Marley 68% 60% C
. . , (usually) a better & |BettyAnan 86% 70% B
1 - 7 |Paris Winfrey 80% BO% A
course as quickly as possible you don’t solution than IFS
8 | OzzyDickens 95% 30% A*
have to read notes. B e e o 5_|sohnny Roberts 8%
. e L This is an exact duplicate of the Grades-I sample file that you used
Notes usually expand a little on the ~N ;FEHEI 2019 3“"""36‘;0]::;5“‘35‘ at the beginning of: Lesson 3-22: Use a VLOOKUP function for an
. . . . functions up to
information given in the lesson text. \\Adeep {ovhich 15 63 too many". st lookagp
The new IFS and SWITCH 2 Use the IFS function to calculate the grade for each student
functions (introduced in Excel by defining grade data within the function

2019) are mainly intended to
offer a simpler alternative to
nested IF functions,

Sometimes it may be better to “hard code” data (such as the
percentage grade thresholds) within the function itself. This
prevents users from accidentally deleting or changing the grade
percentage thresholds within the worksheet.

If you already know how to do
something simply read the bold text

. . L1 provides a better solution than The argument against this approach is that the worksheet is more
for each step and just do it. Step notes - VLOOKUP difficult to maintain if grade thresholds change in the future.
sometimes provide precise instructions P 1. Clickincell C1.

3 _13 order in which the logic pairs 2. Click: Formulas-»Function Library-»Logical >IFS.
about how to progress if the one-line o i g Ciek e T e :ng -
description is inadequate. Notes also TR unetion srguments Gialog o The T AppeATS.

.p . q . . . In almost all business situations The IFS function accepts up to 127 Logical Test/Value pairs.
often include interesting information 2 VLOOKUP will provide a )
e oy 3. Enter the following pair of arguments:
about the current task. st than the wse o h 5 Ier PN O PR
o o B4<60% e
. . . Value_if_truel = 'Fail
When there is a sample file (or files) to “Fail* &
accompany a lesson/ the file name will - > You will need to click the (] button in the Formula Builder task
be shown in a folder icon. You can T—+p [FS Grades-1 I pane to add the Value_if truel argument.

download the sample file set from:
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Learning by participation

Tell me, and I will forget. Show me, and I may remember. Involve

me, and I will understand.

Confucius, Chinese teacher, editor, politician and philosopher (551-479 BC)

Confucius would probably have agreed that the best way to teach IT skills is hands-on (actively) and not
hands-off (passively). This is another of the principal tenets of The Smart Method® teaching method.

Research has backed up the assertion that you will learn more material, learn more quickly, and understand

more of what you learn if you learn using active, rather than passive methods.

For this reason, pure theory pages are kept to an absolute minimum with most theory woven into the hands-

on lessons, either within the text or in sidebars.

This echoes the teaching method used in Smart Method classroom ¢

ourses where snippets of pertinent

theory are woven into the lessons themselves so that interest and attention is maintained by hands-on

involvement, but all necessary theory is still covered.

Session Three: Advanced Functions

Whenever something can easily go
wrong, or when the subject text is

L particularly important, you will see the
important sidebar. You should always
read important sidebars.

Each lesson models a real-world
business problem. You'll immediately

rappreciate the value and relevance of
each skill you learn.

FovcalieetiRmiES = The Logical Test is an expression that returns TRUE or FALSE.
\;5?: ; In this case the test asks if Johnny Caine’s percentage is less
jve if el = “Fa

ra - than 60%.

ol o = As Johnny scored 70% the result is FATSE (as 70% is not less
\;m:?f T than 60%). If Johnnv had a percentage score of less than 60%,

e s the function would have returned the text “Fail”.

L::;:SES = . Note that textual values must be placed in double

Value if tued = marks. If you omit to do this Excel will add for you.
L:m testd = TRUE . 4. Add Logical Test/Value pairs for the o grades (see sidebar).

Ba<0% = .

T 5. Click the Done button.

A & Johnny Caine’s B gradg#€'shown in cell C4.

Logical testd = -

Bd>=90% [+ 6. AutoFill cell C: the end of the range.

Vave_if trues = ‘A 1

A [ All gradeg are now correctly shown. A/
. A B c |D E F
important / 3 s Parcantags Grate | percentags _Grade

. 4 |Johnny Caine 70% B 0% Fail
Excel recognizes text 5 | George Marley 68% C 60% C
as having a value in 6 |BettyAnan 86% A 70% 8
logical expressions 7 |Paris Winfrey 80% A 80% A
8 | Ouzzy Dickens 95% A® 90% A~
If yvou try entering text into the .
Pereentage column you might be 3 Use the IFS function to calculate the grade for each student
surprised to find this result: using the grade data defined in cells E3:F8
& B £ 1. Delete the functions in column C.

3 | Name Percantage_Grade

4 Johnny Caine testup A" 2. Add anew IFS function to cell C4.

5 George Marley 68% €
Excel has evaluated this logic 3. Enter the following pair of Logical Test/Value arguments:
expression: Logical test! = FALSE
="teacup”>90% BA4<SESS e
o BRI 270 ST 3 Value_if_truet = 'Fall
returned TRUE.

“Fail* &

This seems puzzling at first
until it is realized that (behind Notice the use of an absolute reference for cell E5, This is

the scenes) Excel does assign. . N
oy e needed to make sure that the formula AutoFills correctly.

A goal of this book is not to waste your
time by explaining any skill twice.
Sometimes you may forget something
that has already been covered earlier in
the course.

Cross-references are extensively used
pointing you back to the lesson in
which the relevant skills were learned.
The cross-references also help when
you use this course as a reference book
~ but have forgotten the more basic skills
needed to complete each step.

implement alphabetical sorting If you do not understand absolute references see: Lesson 3-6:
MWreemramsl el Temane Use the SUMIF and COUNTIF functions to create conditional
always higher than any number totals.
so that (in an A-Z sort) : . :
exs will aluways come 4. Add appropriate Logical Test/Value pairs for the other grades.

before text. 5. Click the Done button.
To wark around this 6. AutoFill cell C4 down fo the end of the range.
peculiarity, you could add a
new first Logical Test/Value pair Exactly the same grade values are now shown. The difference
to ensure that the value in from the first approach is that the grades will change if the
column B was numeric like this: Percentage/Grade thresholds shown in cells E3:F8 change in
Logical test! = FALS! the future.

ISNUMBER(B4)=FALSE & 4 Save your work as IFS Grades-2.

Value if true1 =

“Error o
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We encourage you to print this free book

E-books can only be obtained and downloaded from https://thesmartmethod.com (the publisher). Our e-
books are published in full color as regular PDF files. This means that you can read them on just about any
device without the bother of finding and installing reader software.

For classroom use we recommend that you print this book

Unlike most e-books, this one isn’t locked to prevent printing (this is also true for all other Smart Method e-
Books). While this book is useful for self-instruction, it is also ideal for teaching structured, objective-led,
and highly effective classroom courses. Even though you can read this book on an iPad*, personal computer
or e-Book reader, some students find it easier to use if you print it onto paper. You may legally print copies
of this basic skills book (for yourself or your students) with only two conditions:

1. You must print the basic skills book exactly as it is published and may not add or remove any book
content or copyright notices.

2. You may not make any charge of any sort for the basic skills books that you print. It is permissible,
however, to give free copies of the book to students who attend a free (or paid for) class or course.

For classroom courses you can obtain a professional-looking result by printing on both sides of the paper.
You can then punch the pages and place them into a binder. Make sure that odd pages appear on the right-
hand side. This enables each two-page lesson to be viewed without turning the page.

For a professional touch you can also put a color insert onto the front cover (you'll find front and back cover
images on our web site. Here’s how the resulting binder will look:

Leam

Excel 2019 Qur e-books are not
B ‘

locked with DRM (digital
rights management)

You can legally print
your e-book for your
own personal use.

You can find full instructions for printing and binding this free e-book (along with the color front and back
cover pages) at: https://thesmartmethod.com/printing-the-basic-skills-course.

You can obtain printed for under four dollars delivered free.

According to Lyra Research it costs between $0.05 and $0.08 cents per page to laser print a single black and
white page. This means that it will cost between $6.00 and $9.60 to print this book yourself on a laser
printer. If you need five or more books you can save a considerable amount of money by ordering perfect-
bound paper printed books (with glossy color cover) from ourselves using our not-for-profit printing
service. You can only order these not-for-profit books from: https://thesmartmethod.com/wholesale-
printed-books. You can also order any Smart Method titles at wholesale prices from this page.

The Basic Skills paper books are often used as free giveaways by employment agencies (for job applicants
who need Excel skills) by employers (to empower their employees with basic Excel skills at minimal cost)
and by teachers who wish to teach their students basic Excel skills.

*If you are an iPad user you can add this e-book to your iBook library. The procedure for adding this e-book to your iBook library is detailed in a step-by-

step guide at: https://thesmartmethod.com/how-to-save-and-view-a-pdf-e-book-on-an-ipad.
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Introduction

Welcome to Learn Excel 2019 for Mac Essential Skills with The Smart Method®. This book has been designed to
enable students to master Excel 2019 for Mac by self-study. The book is equally useful as courseware in
order to deliver courses using The Smart Method® teaching system.

Feedback

At The Smart Method® we love feedback — both positive and negative. If you have any suggestions for
improvements to future versions of this book, or if you find content or typographical errors, the author
would always love to hear from you.

You can make suggestions for improvements to this book using the online form at:

https://thesmartmethod.com/contact

Future editions of this book will always incorporate your feedback so that there are never any known errors
at time of publication.

If you have any difficulty understanding or completing a lesson, or if you feel that anything could have been
more clearly explained, we’d also love to hear from you. We’ve made hundreds of detail improvements to
our books based upon reader’s feedback and continue to chase the impossible goal of 100% perfection.

Downloading the sample files

In order to use this book it is sometimes necessary to download free sample files from the Internet.

The process of downloading the free sample files is explained step-by-step in: Lesson 1-7: Download the sample
files and open/navigate a workbook.

Problem resolution

If you encounter any problem using any aspect of this course, you can contact us using the online form at:

https://thesmartmethod.com/contact

We'll do everything possible to quickly resolve the problem.

The Excel version that was used to write this book

This book is written purely for Excel 2019 for Mac. You'll discover exactly which version your computer is
running in: Lesson 1-3: Check that your Excel version is up to date. You can also use this book if you are using
the subscription version of Excel 2019 for Mac (also known as Excel 365), but there may be some minor
differences.

This edition was written using the macOS (OS X) High Sierra (10.13) operating system. Excel 2019 for Mac can
also run under Sierra (10.12) and any future macOS version. If you're using a different version of macOS this
book will be equally relevant, but you may notice small differences in the appearance of some of the
screenshots in the book. This will only occur when describing an operating system (rather than an Excel)
feature.

Users of earlier operating system versions should also consider updating their operating system to Sierra, as
Apple offer a free update (or at least they did at the time of writing this book in January 2019).
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Typographical Conventions Used In This

Book

This guide consistently uses typographical conventions to differentiate parts of the text.

When you see this Here’s what it means

Click Line Color on the left-hand bar and then
click No line.

Italics are used to refer to text that appears in a
worksheet cell, an Excel dialog, on the Ribbon,
or elsewhere within the Excel application.
Italics may sometimes also be used for
emphasis or distinction.

Click: @>File>Open...

FICW Edit View Insert Form
New Workbook 8N
New from Template... 3P

Open Recent

Move the cursor to the Menu Bar at the top of
the screen.

Click the File menu and click the Open...
option from the drop-down list.

Click: Home=> Underline.

Home

@

R 3 cut Calibri (Body)
- ) Copy ¥

Paste &7 Format B |1 Hk'

Click on the Ribbon’s Home tab and then click
the Underline button (that’s the left-hand side
of the button, not the drop-down arrow next
to it).

Don’t worry if this doesn’t make sense yet.
You will cover the Ribbon in depth in session
one.

Click: Home~>

Underline Drop Down->Double Underline.
u - v|| & Iv i =

U Underline

Click on the Ribbon’s Home tab and then look
for the Font group. Click the drop-down arrow
next to the Underline button (that’s the right-
hand side of the button) within this group and
then choose Double Underline from the drop-
down list.

Click:

&> Excel>Preferences—>
Formulas and Lists=>Custom Lists—>
Import

This is a more involved example.

1. Move the cursor to the Menu Bar at the
top of the screen.

2. Click the Excel menu and click Preferences
from the dropdown list.

The Excel Preferences dialog appears.

3. Find the Formulas and Lists group in the
dialog and click the Custom Lists button.

Another dialog pops up.
4.  Click the Import button.

Type: European Sales into the cell.

Whenever you are supposed to actually type
something on the keyboard it is shown in bold
faced text.

12
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Introduction

Press <Cmd> + <Z>.

You should hold down the Cmd (¥£) key and
then press the Z key.

When a lesson tells you to click a button, an

Y AutoSum image of the r}elevant button w.ill ofter} b(?
shown either in the page margin or within the
text itself.

note

In Excel 2019 there are a
possible 16,585 columns and
1,048,476 rows. This is a great
improvement on earlier
versions.

If you want to read through the book as
quickly as possible, you don’t have to read
notes.

Notes usually expand a little on the
information given in the lesson text.

important

Do not click the Delete button at
this point as to do so would
erase the entire table.

Whenever something can easily go wrong, or
when the subject text is particularly important,
you will see the important sidebar.

You should always read important sidebars.

tip
Moving between tabs
using the keyboard

You can also use the
<Cmd>+<PgUp> and
<Cmd>+<PgDn> keyboard
shortcuts to cycle through all of
the tabs in your workbook.

Tips add to the lesson text by showing you
shortcuts or time-saving techniques relevant
to the lesson.

The bold text at the top of the tip box enables
you to establish whether the tip is appropriate
to your needs without reading all of the text.

In this example you may not be interested in
keyboard shortcuts so do not need to read
further.

anecdote

I ran an Excel course for a small
company in London a couple of
years ago...

Sometimes I add an anecdote gathered over
the years from my Excel classes or from other
areas of life.

If you simply want to learn Excel as quickly as
possible you can ignore my anecdotes.

trivia

The feature that Excel uses to
help you out with function calls
first made an appearance in
Visual Basic 5 back in 1996 ...

Sometimes I indulge myself by adding a little
piece of trivia in the context of the skill being
taught.

Just like my anecdotes you can ignore these if
you want to. They won’t help you to learn
Excel any better!

The World’s Fastest
Cars

When there is a sample file (or files) to
accompany a lesson, the file name will be
shown in a folder icon. You can download the
sample file from: https://TheSmartMethod.com.
Detailed instructions are given in: Lesson 1-7:
Download the sample files and open/navigate a
workbook.

© 2019 The Smart Method® Ltd
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How to use this course

This course utilizes some of the tried and tested techniques developed after teaching vast numbers of people
to learn Excel during many years teaching Smart Method classroom courses.

In order to master Excel as quickly and efficiently as possible you should use the recommended learning
method described below. If you do this there is absolutely no doubt that you will master the advanced Excel
skills taught in this book.

Three important rules

#1 - Complete the course from beginning to end

It is always tempting to jump around the course completing lessons in a haphazard way.
We strongly suggest that you start at the beginning and complete lessons sequentially.

That's because each lesson builds upon skills learned in the previous lessons and one of our goals is not to
waste your time by teaching the same skill twice. If you miss a skill by skipping a lesson you'll find the later
lessons more difficult, or even impossible to follow. This, in turn, may demoralize you and make you
abandon the course.

#2 If possible, complete a session in one sitting

The book is arranged into sessions and lessons.

You can complete as many, or as few, lessons as you have the time and energy for each day. Many learners
have developed Excel skills by setting aside just a few minutes each day to complete a single lesson.

If it is possible, the most effective way to learn is to lock yourself away, switch off your telephone, and
complete a full session, without interruption, except for a 15-minute break each hour. The memory process is
associative, and we've ensured that the lessons in each session are very closely coupled (contextually) with
the others. By learning the whole session in one sitting, you'll store all that information in the same part of
your memory and will find it easier to recall later.

The experience of being able to remember all of the words of a song as soon as somebody has got you
"started" with the first line is an example of the memory's associative system of data storage.

#3 Rest at least every hour

In our classroom courses we have often observed a phenomenon that we call "running into a wall". This
happens when a student becomes overloaded with new information to the point that they can no longer
follow the simplest instruction. If you find this happening to you, you've studied for too long without a rest.

You should take a 15-minute break every hour (or more often if you begin to feel overwhelmed) and spend it
relaxing rather than catching up with your e-mails. Ideally you should relax by lying down and closing your
eyes. This allows your brain to use all of its processing power to efficiently store and index the skills you've
learned. We've found that this hugely improves retention of skills learned.

14 https://TheSmartMethod.com
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How to work through the lessons

At the end of each session, complete the session exercise

Keep attempting the exercise at the end of each session until you can complete it without having to refer to
lessons in the session. Don't start the next session until you can complete the exercise from memory.

At the end of each session, review the objectives

The session objectives are stated at the beginning of each session.

Read each objective and ask yourself if you have truly mastered each skill. If you are not sure about any of
the skills listed, revise the relevant lesson(s) before moving on to the next session.

You will find it very frustrating if you move to a new session before you have truly mastered the skills
covered in the previous session. This may demoralize you and make you abandon the course.

How to best use the incremental sample files

Many lessons in this course use a sample file that is incrementally improved during each lesson. At the end
of each lesson an interim version is always saved. For example, a sample file called Sales-1 may provide the
starting point to a sequence of three lessons. After each lesson, interim versions called Sales-2, Sales-3 and
Sales-4 are saved by the student.

A complete set of sample files (including all incremental versions) are provided in the sample file set. This
provides three important benefits:

e If you have difficulty with a lesson it is useful to be able to study the completed workbook (at the
end of the lesson) by opening the finished version of the lesson's workbook.

e When you have completed the book, you will want to use it as a reference. The sample files allow
you to work through any single lesson in isolation, as the workbook's state at the beginning of each
lesson is always available.

e When teaching a class one student may corrupt their workbook by a series of errors (or by their
computer crashing). It is possible to quickly and easily move the class on to the next lesson by
instructing the student to open the next sample file in the set (instead of progressing with their own
corrupted file or copying a file from another student).

The time you spend learning Excel is hugely worthwhile

Excel is a huge and daunting application and you'll need to invest some time in learning the skills presented
in this course. This will be time well spent as you'll have a hugely marketable skill for life. With 1.2 billion
users worldwide, it is hard to imagine any organization of any size that does not value Excel skills.

If you persevere with this course there is no doubt that you will master Excel. A little time and effort is
needed but the skills you'll acquire will be hugely valuable for the rest of your life.

Enjoy the course.

© 2019 The Smart Method® Ltd 15
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Session One: Basic Skills

A bad beginning makes a bad ending.
Euripides, Aegeus (484 BC - 406 BC).
Even if you are a seasoned Excel user, I urge you to take Euripides’

advice and complete this session. You'll fly through it if you already
know most of the skills covered.

In my classes I often teach professionals who have used Excel for over ten
years and they always get some nugget of fantastically useful information

from this session.

In this session I teach you the absolute basics you need before you can
start to do useful work with Excel 2019.

I don’t assume that you have any previous exposure to Excel (in any
version) so I have to include some very basic skills.

Session Objectives

By the end of this session you will be able to:

Configure your mouse and understand right clicking

Start Excel and open a new blank workbook

Check that your Excel version is up to date

Change the Office Theme

Minimize, re-size, move and close the Excel window
Understand Full Screen view

Download the sample files and open/navigate a workbook
Save a workbook to a local file

Understand common file formats

Pin a workbook and understand file organization

View, move, add, rename, delete and navigate worksheet tabs
Use the Ribbon

Understand Ribbon components

Customize the Quick Access Toolbar and preview the printout
Understand views

Hide and show the Formula Bar and Ribbon

Use the help search system

© 2018 The Smart Method® Ltd
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note

If you have a very old
mouse

If you have an Apple mouse
that was manufactured before
2005, it’s possible that it truly
has only one button and can’t
be configured to allow a ‘right
click’.

If this is the case, I'd strongly
recommend purchasing a
mouse that has two buttons.

This book will always use the
terms ‘left click” and ‘right
click” to indicate which of the
mouse buttons you should use.

If you can’t attach a two-button
mouse, you can simulate a
‘right click” by holding down
the <Ctrl> key before clicking
with the mouse.

note

If you are using a
trackpad

If you're using a laptop
computer you might use a
trackpad instead of a mouse. In
this case you will see a Trackpad
option under System
Preferences instead of the
Mouse option.

You can use this to configure
right clicking using a trackpad,
which is done either by clicking
with two fingers, clicking in the
bottom-right corner or clicking
in the bottom-left corner.

It’s usually easier to use Excel
with a mouse, but you should
be able to complete this course
using a trackpad without any
problems.

Lesson 1-1: Configure your
mouse and understand right
clicking

If you're using your Mac with default settings and hardware, it’s likely
that your mouse appears to only have one button instead of two. This is
great for simple programs, but makes it more difficult to use complex
business applications like Excel.

It is possible to work with Excel using a single mouse button, but many
features are much easier to use if you're able to ‘right click’ to access a
contextual menu.

Even if your mouse only appears to have a single button, it’s likely that it
can be configured to recognize the difference between a ‘left click” and
‘right click’. Only very old mice truly only have one button (see sidebar if
this is the case).

This lesson will show you how to enable two-button functionality on
your mouse.

1  Test your mouse.

Move your mouse pointer down to any of the icons on the Dock at
the bottom of the screen and click the right mouse button.

Even if your mouse only seems to have one button, click the mouse
with your finger on the right side of the mouse.

Remove from Dock

Show Launchpad

eon
If a contextual menu appears as shown above, your mouse is
already configured for right clicking and you don’t need to do

anything else. If no menu appears and a program opens instead,
read on to learn how to enable right-clicking.

2 Open the System Preferences dialog.

If it hasn’t been removed, you should see the System Preferences
icon on the Dock at the bottom of the screen:

If you don’t see this icon, you can access System Preferences by
going to the Launchpad by either clicking its icon on the Dock or
pressing the <F4> key.

Click the System Preferences icon.

The System Preferences dialog appears:

18
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trivia
The history of the
Apple mouse

The very first Apple mouse was
included with the Apple Lisa
system, released in 1983. The
Lisa mouse had only one
button, setting a standard that
Apple followed for over 22
years.

The design of Apple’s mice
remained very similar to the
Lisa Mouse until the Apple
Desktop Bus Il mouse was
released in 1993. This was the
first of Apple’s mice to use the
rounded shape that is used by
almost every computer mouse
today.

The Apple Desktop Bus mouse
was followed by the Apple USB
Mouse in 1998. Nicknamed the
"hockey puck’ because of its
round shape, the USB Mouse
was not very well received due
to its short cable and tendency
to rotate.

In the year 2000, the Apple Pro
Mouse was released. The Apple
Pro Mouse was Apple’s first
optical mouse, and the first to
use the ‘0-button” design that
has continued in Apple’s latest
generation.

The Apple Mighty Mouse was
released in 2005, and was the
first Apple mouse capable of
both left and right-click, as well
as including a trackball.

The most recent Apple mouse
as of 2018 is the Apple Magic
Mouse 2, first released in 2015.
The Magic Mouse 2 replaces
the trackball with the ability to
perform gesture controls on the
surface of the mouse itself.

@ > HHE System Preferences
i @ & o @
General Desktop & Dock Mission Language Security Spotlight  Notifications
Screen Saver Control & Region & Privacy

[] & N\ £
v - N8
Displays Energy Keyboard Mouse Trackpad Printers & Sound Startup
Saver Scanners Disk

Open the Mouse settings dialog.

Click the Mouse icon in the System Preferences dialog (the 4t icon
from the left on the second row).

Mouse

The Mouse dialog appears:

off

Primary Button

©

Primary Button E

off ™

Serolling:  Vertical and Horizontal E

Note that this dialog may look different depending upon the type
of mouse you are using.

Set the right mouse button to Secondary Button.

1. Click the drop-down menu pointing to the right mouse button
and click Secondary Button from the shortcut menu.

Secondary Button

2. Close the Mouse dialog by clicking the red Close button. L]
Test your mouse again.

Try right-clicking one of the Dock icons again. This time you
should find that the contextual menu appears.

© 2019 The Smart Method® Ltd
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Lesson 1-2: Start Excel and
open a new blank workbook

1 Move your mouse cursor to the bottom of the screen to
display the Dock if it's not already visible.

LSOBT

2 Click the Launchpad icon on the Dock.

£l

All of your installed applications are displayed, including Microsoft
Excel.

wg o pd X

Microsoft Word Microsoft PowerPoint Microsoft Excel

3 Add the Microsoft Excel icon to your Dock.

You'll be using Excel a lot, so it makes sense to add it to the Dock.
This will make it appear at the bottom of the screen in future so
you'll be able to start Excel with just one click.

To add Excel to the Dock, point to the Microsoft Excel icon in the
list, then click and drag it down onto the Dock.

A ] o

4 Click the Microsoft Excel icon to start Excel.

You can click the Microsoft Excel icon either from the Dock or from
the Launchpad screen.

Excel starts and is displayed on the screen:

Microsoft Excel

Take a
tour

Blank Workbook Welcome to Excel Make a List

20 https://TheSmartMethod.com
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After you’ve started Excel 2019

Microsoft Excel
) Personal Q
Blank Workbook Welcome 10 Excel
— Total a List
| —— s fom
Make a List Total a list
=== Budget
Cancel Create

Now that Excel 2019 has started, it needs to know whether you want to
create a new workbook, or whether you want to open a workbook that
was created earlier.

When creating a new workbook, Excel also offers to give you a “flying

nOte start” by using a template. Templates are sample workbooks that you can
. adapt and modify for your own needs. The idea is very good but, in

POtentlaI_ problems reality, templates are not usually a good choice as it can take longer to

when using templates adapt them to your true needs than to design from scratch (see sidebar).

Many of Microsoft’s templates In this lesson you'll create a blank workbook.

have been created using some

very advanced Excel skills and 1 Create a new blank WorkbOOk.

teChmques} L on ke 1E2 ol 1. Click the left mouse button on the Blank Workbook template.

them there’s a danger that you

may depend upon a workbook 2. Click the Create button in the bottom-right corner.

you don’t understand and are

unable to maintain. Alternatively, you can double-click on the Blank Workbook template.

If you progress to the Essential The Excel 2019 screen is displayed, showing a blank workbook:

Skills book in this series, you'll
learn how to create your own

D d d = Book1 Q~ v

custom templates in: Session Insert Page Layout  Formulas Data  Review View &+ Share A
Three: Taking Your Skills to the L% X% A= (y . [l conditional Formatting * = Q i
Next Level. A Feee — & Format as Table ~ B
Paste & Font Alignment Number f Coll Styles + Cells Editing

Templates you create yourself o S
are far more useful. Because Al . s v
you understand how they are =

. . A B C D E F G H I
built, you will be able to —

. . 1 ]
maintain them, and any 2

workbook created from them.
2 Leave the workbook open for the next lesson.
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note

Office 365 and feature
updates

There are now two ways of
purchasing Excel — either as a
one-off purchase or as part of a
subscription service called
Office 365.

You will receive monthly
security and bugfix updates
regardless of how you
purchased Excel, but you will
only receive new features if you
have an Office 365 subscription.

The screenshots in this course
show the most up-to-date
version of Excel 2019, so some
things may appear differently if
you are using Excel 365 (the
subscription version).

Lesson 1-3: Check that your
Excel version is up to date

Automatic Updates

Normally Microsoft Office (including Excel) will look after updates
without you having to do anything if Automatic Updates are enabled.

If you don’t enable Automatic Updates, there is a danger that you may
have an old, buggy, out of date version of Excel installed.

This lesson will show you how to enable Automatic Updates and make
sure that you are using the latest (most complete, and most reliable)
version of Excel 2019.

1

Start Excel and open a new blank workbook (if you have not
already done this).

You learned how to do this in: Lesson 1-2: Start Excel and open a new
blank workbook.

Make sure that Automatic Updates are enabled.

1. If the Menu Bar isn’t visible at the top of the screen, move the
mouse cursor to the top of the screen to make it appear.

You should see the following options:

® Excel File Edit View Insert Format Tools Data Window Help|

If you see a different set of options, it means the Excel window
isn’t selected. Make sure that the Excel window is selected
either by clicking on it or by clicking the Microsoft Excel icon
on the Dock.

2. Click: @>Help->Check for Updates.
The Microsoft AutoUpdate dialog appears.
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note

The Office Insider
program

You might have noticed the
tempting option to Join the
Office Insider program in the
Microsoft AutoUpdate dialog.

Joining the Office Insider
program allows Microsoft to
install updates on your
computer that have not yet
been fully tested. This means
that you get early access to new
features, but it also greatly
increases the chances of
encountering bugs in the
untested early releases.

Microsoft offer two options for
Office Insider: Office Insider
Slow and Office Insider Fast.

The Slow option gives you early
access to new updates that have
already had some significant
testing but are not yet
considered ready for release.

The Fast option gives you
significantly earlier updates,
but with significantly more risk
of encountering bugs and
errors.

Joining the Office Insider
program is not a good idea for
most users. It is better to wait
for the final versions that have
been fully tested than to risk
the potentially disastrous
consequences of downloading
untested updates.

O Microsoft AutoUpdate

AutoUpdate checks for update versions of your Microsoft software. For more
information about AutoUpdate, see Help.

How would you like updates to be i lled?

Manually Check
© Automatically Check
Automatically Download and Install

Join the Office Insider program to get early access to new releases

If you choose to participate in this program, diagnostic data will be collected
from your use of the services and is required to be collected from all
participants in this program. This diagnostic data is comprised of
information about your Office settings, device capabilities, whether Office is
performing properly, and how you use apps, features, and devices. This
includes error reporting. Diagnostic data is used to keep Office secure and
up to date, troubleshoot problems, and make product improvements.

Choose how you get Insider builds Office Insider Slow +

Office Insider Slow - Best for Insiders who want to get early access to fully
supported builds with minimal risk and provide feedback to make Office
great.

Learn more
Privacy statement

Program terms

Check for Updates

3. Make sure that Automatically Check is selected.

Check for updates and update to the latest version if
necessary.

1. Click the Check for Updates button.

You may be prompted to enter your password to confirm that
updates should be allowed.

2. Install any updates that are available.

3. Click the red Close button [®]in the top-left corner of the
Microsoft AutoUpdate window to close it.

Click the Close button [®] in the top-left corner of the Excel
window to close Excel.

© 2019 The Smart Method® Ltd

23



Learn Excel 2019 for Mac Basic Skills with The Smart Method

Lesson 1-4: Change the Office

Theme

Excel 2019 allows you to change the colors of screen elements (such as the
Menu Bar and Ribbon) by selecting one of two themes. The available
themes are called Colorful, and Classic.

J ¥ B The. Q- v 1
Page Layout Formulas Data Review View &t Share -
o= % A —_— O/ = Conditional Formatting ~ Te=1 Q
- A _— - ) m v v
LI—\ 5 - Slen.e — (o) & Format as Table v Em=a
Paste . Font Alignment Number . Cells Editing
< & Cell Styles ~
Al . fx Rank e
A B c D E
1 |Rank _Countr\r GDP - per capita (PPP) Date of information
2 1 Qatar $137,200 2014 est.
3 2 Luxembourg $97.600 2014 est.
4 3 Liechtenstein 589,400 2009 est.
5 4 Macau $88,700 2013 est.

Excel 2019 uses the Colorful theme as the default. The Colorful theme
makes it clear which of the Office applications you are using as Word,
Excel, PowerPoint, Outlook and other Office applications each have their

own unique color.

The previous version of Excel for the Mac (Excel 2011) didn’t provide the
option to change themes and was fixed to the Classic color scheme.

Classic
eoe M U J ¥ [ The.. |Q-searchsSheet ©-
Home Insert Page Layout Formulas Data Review View &F Share ~
@ X — ry || Conditional Formatting *  14=1 Q
v A - —_— o " v
'J—\ - =3 - o ¢ Format as Table ~ —_—
Paste Font Alignment  Number Cells Editin
& = Y / Cell Styles + s
Al . fx Rank -
A B c D E
1 |Rank JCountry GDP - per capita (PPP) Date of information
2 1 Qatar $137,200 2014 est.
3 2 Luxembourg $97,600 2014 est.
4 3 Liechtenstein 589,400 2009 est.
S 4 Macau $88,700 2013 est.

The Classic theme doesn’t have the unique color scheme for each Office
application and instead uses the gray color scheme that was used by

Excel 2011 and earlier versions of Excel for the Mac.
1 Open Excel and open a new blank Excel workbook.
2  Change the Office Theme.

1. Click: > Excel>Preferences.
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tip
You can also open the Excel

Preferences dialog by using the
<Cmd>+<,> keyboard shortcut.

note

Themes affect every
Office application

When you set a theme in Excel
you are actually changing the
theme for the entire Office 2019
application.

This means that you will have a
consistent experience when
using other Office applications
such as Word and PowerPoint.

3

& [E00 File Edit View
About Microsoft Excel
Preferences... S 38,
Sign Out...

Services >
Hide Excel 8 H
Hide Others X ¥H
Quit Excel #Q

The Excel Preferences dialog appears.
Click General from the Authoring group.

Authoring
iy i =)
General View Ribbon &
Toolbar

The dialog changes to show the General options.

In the Personalize group, click the Office theme dropdown menu
and select Classic.

Personalize

User name: Microsoft Office User

Office theme v Colorful
Classic

Web Options...

A dialog pops up to inform you that this change will affect all
Office applications (see sidebar).

Theme choices apply to all Office apps

The theme you have selected will be applied to your
other installed Office apps the next time each one is

launched.

Click OK to close the dialog.
The color scheme changes immediately.

Experiment with each theme until you discover the one you
prefer. All of the screenshots in this book were done using the
Colorful theme. If you choose the Classic theme, the screenshots
in the book may look slightly different to what you see on your
computer screen.

Close Excel.

© 2019 The Smart Method® Ltd
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Lesson 1-5: Minimize, re-size,
move and close the Excel
window

The main Excel window has a dazzling array of buttons, switches and
other artifacts. By the end of this book they will all make sense to you and
you'll feel really comfortable with Excel.

For now, you'll explore the big picture by looking at how the Excel
window can be sized and moved. The details will come later.

1  Open Excel.

2 Use the Blank Workbook template to open a new blank
workbook.

You learned how to do this in: Lesson 1-2: Start Excel and open a new
blank workbook.

3 Understand the Close, Minimize, and Zoom buttons

At the top left corner of the Excel window you can see three
buttons.

Close, Minimize and Zoom buttons

D g (L) Q- ©-

Insert  Page lLayout Formulas Data » &+ Share -
- . — B Conditional Formatting ~ 141
5 M | == % v . m| (
iy Format as Table ~
Clipboard Font Alignment Number . Cells Ec
& Cell Styles ~
Al . Ix -
These are the Close, Minimize and Zoom buttons:
Minimize
Close Zoom
| |

Don’t worry if they look like empty circles on your screen. The
icons will appear when you move your mouse close to them.

You'll learn more about the Zoom button and Full Screen view in
the next lesson: Lesson 1-6: Understand Full Screen view.

4 Minimize and restore the Excel window
Try clicking the Minimize button.

Minimize reduces Excel to a button on right side of the Dock.

Click this button again to restore the window to its previous size.
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note

Other ways to close
Excel

There are two other ways of
closing an Excel window.

1. Click:

&> File>Close
2. Press the <Cmd>+<W>
keys on your keyboard.
note

Closing Vs Quitting

Excel doesn’t exit completely,
even if you close every open
Excel window. Instead, it stays
running in the background so it
can quickly reopen if it is
needed again.

This usually isn’t a problem,
but large numbers of open
programs can eventually cause
your computer to run slowly.

To completely close Excel, click:
&> Excel>Quit Excel

You can also do this by
pressing the <Cmd>+<Q> keys
on your keyboard or right-
clicking on the Excel icon on
the Dock and clicking Quit
from the shortcut menu.

You can also restore the Excel window by clicking the Excel icon
on the Dock (the same icon that you use to start Excel).

Re-size the Excel window.

Hover over either the side of the Excel window, or a corner of the
window, with your mouse cursor. The cursor shape changes to a
double-headed arrow.

1

= + 100%

When you see either cursor shape, hold down the mouse button
and move the mouse (this is called click and drag) to re-size the
window.

Clicking and dragging a corner allows you to change both the
height and width of the window.

Clicking an edge allows you to change only one dimension.
Move the Excel window.

Click and drag the Title Bar (the bar at the very top of the window)
to move the Excel window around the screen.

Book1

Formulas Data Review

Close Excel.

Click on the Close button [®] at the top left of the Excel window.
This is the most common way to close an Excel window.

There are also two lesser known (and lesser used) methods of
closing Excel windows (see sidebar).

Note that, on the Mac, closing all Excel windows is not the same as
quitting Excel (see sidebar for more on this).

© 2019 The Smart Method® Ltd
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Lesson 1-6: Understand Full
Screen view

You saw how to use the Minimize and Close buttons in the previous
lesson, but you haven’t yet used the Zoom button.

Minimize
CloseI | I:_'oom

The Zoom button allows you to enter Full Screen view, which dedicates
as much screen space as possible to the Excel window. You'll see how to
use the Zoom button in this lesson.

1  Open Excel.

2 Use the Blank Workbook template to open a new blank
workbook.

3  Enter Full Screen view.
Click the Zoom button to enter Full Screen view. [®]
The Excel window expands to fill the entire screen.
4 Access the Dock and Menu Bar while in Full Screen view.

The first thing you may notice is that the Menu Bar has
disappeared from the top of the screen and the Dock has
disappeared from the bottom. They have been hidden so that as
much screen space as possible can be dedicated to Excel, but they
can still be accessed.

1. Move the mouse cursor to the top of the screen.

hn® Excel File Edit View Insert

The Menu Bar appears, along with the Close, Minimize and
Zoom buttons.

2. Move the mouse cursor to the bottom of the screen.

39
40

kE®OB

Read k.

The Dock appears.
S  Exit Full Screen view.

1. Move the mouse cursor to the top of the screen to make the
Close, Minimize and Zoom buttons appear.

(e o]
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tip
Alternative ways to

enter and exit Full
Screen view

As well as using the Zoom
button, there are a few other
ways to enter and exit Full
Screen view.

One alternative is to click:
®—>View—> Enter Full Screen

...or to exit full screen view:
&> View—>Exit Full Screen

You can also enter and exit full
screen view by using the
keyboard shortcut:
<Ctrl>+<Cmd>+<F>

...finally, you can also exit full
screen view by simply pressing
the <Esc> key.

note

If there is no Alt key
on your keyboard

Before 2006, Apple keyboards
used the Option key instead of
the Alt key.

If you don’t have an Alt key on
your keyboard, use the Option
key instead. It will work in
exactly the same way.

7

Notice that the Zoom button has a different appearance while
in Full Screen view.

2. Click the Zoom button once more to exit Full Screen view.
See sidebar for alternative ways to enter and exit Full Screen view.

Maximize the Excel window without entering Full Screen
view.

Full Screen view is useful when you need as much screen space as
possible, but it also makes it more difficult to access the Menu Bar
and Dock, and can interfere with Excel’s window management
features.

Windows in Full Screen view can’t be automatically rearranged by
Excel, as you'll see in: Lesson 2-2: Create a new workbook and view two
workbooks at the same time.

Fortunately, there’s a solution that enables you to maximize a
window without entering Full Screen view.

1. Move the mouse cursor to the Close, Minimize and Zoom
buttons so that their icons appear.

@& o

2. Hold down the <Alt> key (see sidebar if there is no <Alt> key
on your keyboard).

When you hold down the <Alt> key, the Zoom icon changes
into a + symbol.

®c o

3. Keeping <Alt> held down, click the Zoom button.

The window expands to fill the screen without entering Full
Screen view.

This method of maximizing the window doesn’t allow Excel to
fill as much screen space as Full Screen view, because it allows
the Dock and Menu Bar to remain visible.

Unless you have a very small screen, it’s usually better to
avoid Full Screen view. Keeping the Dock and Menu Bar
visible makes it easier to switch between programs and
windows, as well as providing more convenient access to
Excel’s own features.

Close Excel.

© 2019 The Smart Method® Ltd
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important

Organizing your
sample files folder

When you complete a lesson
that involves a sample file that
is changed, you will be
instructed to save the file with a
suffix.

By the time you've completed
the course you’ll have sample
files such as:

Sales-1
Sales-2
Sales-3
Sales-4 ... etc

The first file is the sample file
that you downloaded and the
others (with the number suffix)
are interim versions as you
complete each lesson.

The sample file set includes the
starting sample file and all
interim versions.

The interim versions are
provided for three reasons:

1. If your work-in-progress
becomes unusable (for example
after a system crash) you can
continue without starting at the
beginning again.

2. If a lesson doesn’t seem to
give the results described, you
can view the example to get
some clues about what has
gone wrong.

3. When you have completed
the course you will use this
book as a reference. The interim
versions allow you to work
through any of the lessons in
isolation if you need to remind
yourself how to use a specific
Excel feature.

It is a good idea to place the
sample files in a different folder
to your saved work. If you
don’t do this you'll be over-
writing the sample interim files
(such as Sales-1, Sales-2 etc)
with your own finished work.

B ~

The Wealth of Nations ]

Lesson 1-7: Download the
sample files and open/navigate
a workbook

Excel uses the analogy of a book that has many pages. In Excel
terminology the term: Workbook is used for the entire book and Worksheet
for each of the pages. You'll be learning more about worksheets later in
this session in: Lesson 1-11: View, move, add, rename, delete and navigate
worksheet tabs.

1 Download the sample files (if you haven’t already done so).
1. Open the Safari web browser and type in the URL:
https://TheSmartMethod.com
2. Click the Sample Files link on the top right of the home page.

3. Download the sample files for:
Excel 2019 Essential Skills for Mac.

Be sure to select the for Mac version of the course, as the
Windows sample files may not work on a Mac.

2 Move the sample files to your Documents folder.

By default, the sample files will be downloaded to your Downloads
folder. They will be easier to access and work with if you move
them to your Documents folder.

1. Open Finder by clicking its icon on the Dock.

E

2. Click the Downloads folder under Favorites.

I © Downloads k

3. (Click and drag the downloaded AllSessions2019Essential file
into the Documents folder.

3 Open the sample workbook: The Wealth of Nations.
1. Open Excel.
2. Click Open on the left-hand menu bar.
3. Click: On my Mac in the central pane.

4. Navigate to your sample files, which should now be in the
Documents folder.

5. Open the AllSessions2019Essential folder.
6. Open the Session 1 folder.

7. Double click The Wealth of Nations to open the sample
workbook.

4  Go to cell ZZ3 using the Name Box.
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note
The Ctrl key

The <Ctrl> key is sometimes
labelled <Control> or just <*>.

Most keyboard shortcuts use
the <Cmd> key interchangeably
with <Ctrl>, and <Cmd> is
Apple’s recommended key for
keyboard shortcuts.

In Excel 2019, the keyboard
shortcuts <Cmd>+<Home> and
<Ctrl>+<Home> both worked,
but the <Cmd>+<Home>
shortcut doesn’t work in the
first release of Excel 2019.

This will probably be fixed in a
future update.

If the <Ctrl> key isn’t working
for you, it has probably been
disabled in your System
Preferences. You can find the
settings for this by clicking
System Preferences, then
Keyboard, and then Modifier
Keys.

ng * (L]
- Q-

Cells Editing

Click here to move

one screen up

Click and drag this button

to quickly move up and ———
down the worksheet.

Click here to move
one screen down

|

Name Box Active Cell Formula Bar

Insert Page Layout Formulas Data » &t Share -
= A . — o/ . || Cjnditional Formatting ~ 14=¢1 ) c
J—\ e — 0 b |
& Fyrmat as Table ~ >
Clipbodtd Font Alignmdht Number ' Cells Edi
7 cIu Styles ~
83 . fx | Luxembourg v
A ] C D
1 Rank Country GDP - per capita (PPP) Date of information
2 1 Qatar $137,200 2014 est.
3 | 2I Luxembourg |397,600 2014 est.
4 3 Liechtenstein 589,400 2009 est.
5 4 Macau 588,700 2013 est.
4 » GDP Life Expectancy Mobile Phones +
Ready 1T N @] - +  100%

Excel uses the letter of the column and the number of the row to
identify cells. This is called the cell address. In the above example
the cell address of the active cell is B3.

In Excel 2019 there are a little over a million rows and a little over
sixteen thousand columns. You may wonder how it is possible to
name all of these columns with only 26 letters in the alphabet.

When Excel runs out of letters it starts using two: X,Y,Z and then
AA, AB, AC etc. But even two letters is not enough. When Excel
reaches column ZZ it starts using three letters: ZX, ZY, ZZ and
then AAA, AAB, AAC etc.

The currently selected cell is called the Active Cell and has a green
line around it. The Active Cell’s address is always displayed in the
Name Box and its contents are displayed in the Formula Bar.

You can also use the Name Box to move to a specific cell.

To see this in action, type ZZ3 into the Name Box and then press the
<Enter> key. You are teleported to cell ZZ3:

A

73 . fx v

Z r Fil) w ¥ v 2z AAA

Active Cell—fp |

2
3| Active Cell Formula Bar
4

Return to cell A1 by pressing <Ctrl>+<Home> ("\).
See sidebar if you can’t find the Ctrl key on your keyboard.

Go to the end of the worksheet by pressing <Ctrl>+<End>

().
Use the Scroll Bars.

There are two scroll bars for the Excel window, which appear
when you move the mouse cursor close to the edges of the screen.

The vertical scroll bar runs from top to bottom of the window and
allows you to quickly move up and down the worksheet.

The horizontal scroll bar is at the bottom of the window and allows
you to move to the left and right in wide worksheets. See sidebar
for how the scroll bars work.

© 2019 The Smart Method® Ltd
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Lesson 1-8: Save a workbook
to a local file

1 Open The Wealth of Nations from your sample files folder (if
it isn’t already open).
2 Save the workbook.
When you are editing a workbook, the changes you make are only
N ote held in the computer’s memory. If there is a power cut or your
computer crashes, you will lose any work that has been done since
You can also use the the last save.
Cmd>+<S> keyboard shortcut
:0 ::v:*;) u>r ‘;Zﬂg are shoried For this reason, you should get into the habit of regularly saving
your work.
Even though you haven’t changed this workbook, save it by
clicking the Save button on the Quick Access Toolbar at the top left of
the screen.
Quick Access Toolbar
O a
Insert Page Layout
Save Button
3  Save the workbook with a different name.

note

You can also use the
<Cmd>+<Shift>+<S> keyboard
shortcut to instantly display the
Save As dialog.

= ™ —

The Wealth of Nations ]

1. Click: @>File>Save As.

If you are signed into a OneDrive, the following dialog
appears:

Save As: | The Wealth Of Nations

OneDrive - Personal

| Documents

] Pictures

Recent Folders
Public
Exercise 8 o '

Documents
Mike Smart's OneDrive

Practice

On my Mac File Format: Excel Workbook (.xIsx) B

Options...

New Folder Cancel

Saving to a OneDrive enables you to store your files online (see
facing page sidebar).

2. If the OneDrive dialog appears, click the On my Mac button.

On my Mac
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note

OneDrive and Cloud
Computing
The Save As dialog allows you

to save your workbook to a
OneDrive:

& OneDrive

A OneDrive can be thought of
as a “disk drive in the sky”.

It is just like the Documents
folder on your computer but
exists on a Microsoft server
many miles away, accessed via
the Internet.

The OneDrive can be very
useful when you need to access
your files from several different
computers.

A OneDrive also provides an
easier way to share files with
others.

The OneDrive is part of a
completely new way of
working called Cloud
Computing.

Support for Cloud Computing
was first added in the Excel
2013 release.

Because Cloud Computing is
such an involved (and
complex) subject it is beyond
the scope of this Basic Skills
book.

The Essential Skills book in this
series devotes an entire session
to Cloud Computing (in Session
Eight: Cloud Computing).

This allows you to save the workbook to your own computer
instead of your OneDrive.

Click the drop-down arrow to the right of the File Format drop-
down list.

A list appears showing a large number of different file types:
File Form N T R

Excel 97-2004 Workbook (.xls)

CSV UTF-8 (Comma delimited) (.csv)
Web Page (.htm)

Excel Template (.xItx)

Excel 97-2004 Template (.xIt)

PDF

Excel Macro-Enabled Workbook (.xlsm)
Excel Binary Workbook (.xIsb)

Single File Web Page (.mht)
v

Most of the time you’ll want to use the default format: Excel
Workbook but there may be times when you’ll need to save in
one of the other formats. You'll learn all about the most
important formats (and when you should use them) in the next
lesson: Lesson 1-9: Understand common file formats. For now,
you'll stay with the default: Excel Workbook format.

Click inside the Save As box.
Type: The Wealth of Nations Copy

Save As: | The Wealth Of Nations Cop\,_'l

Click the Save button.

Notice that the name of the workbook in the title bar (at the top
of the window) has now changed, indicating that you are now
viewing the new workbook that you have just saved.

D4 & 5 0 The Wealth Of Nations Copy Q- ©-

Insert Page Layout Formulas Data Rk ew View Developer &t Share ~

A . i o/ . B! Conaiigfl Formatting = 1es1 .
. = AJ 7 f - u Q

Font Alignment Number . Cells Editing
7 v
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v Excel Workbook (.xIsx)

Excel 97-2004 Workbook (.xls)

CSV UTF-8 (Comma delimited) (.csv)
Web Page (.htm)

Excel Template (.xItx)

Excel 97-2004 Template (.xIt)

PDF

Excel Macro-Enabled Workbook (.xlsm)
Excel Binary Workbook (.xlsb)

Single File Web Page (.mht)

Excel Macro-Enabled Template (.xItm)
Tab delimited Text (.txt)

UTF-16 Unicode Text (.txt)

Excel 2004 XML Spreadsheet (.xml)
Microsoft Excel 5.0/95 Workbook (.xls)
Comma Separated Values (.csv)
Space Delimited Text (.prn)

Macintosh Formatted Text (.txt)
MS-DOS Formatted Text (.txt)
Macintosh Comma Separated (.csv)
MS-DOS Comma Separated (.csv)
Data Interchange Format (.dif)
Symbolic Link (.slk)

Excel Add-in (.xlam)

Excel 97-2004 Add-in (.xla)

Strict Open XML Spreadsheet (.xlsx)
OpenDocument Spreadsheet (.ods)

Lesson 1-9: Understand
common file formats

1  Open a new blank workbook.

You learned how to do this in: Lesson 1-2: Start Excel and open a new
blank workbook.

2 View the file formats supported by Excel.
1. Click @>File>Save As.
2. Click the drop-down arrow to the right of the File Format list.

File Format: Excel Workbook (.xIsx)

A list appears showing all of the different file formats
supported by Excel (see sidebar).

3 Understand the most important file formats.

Excel Workbook (the Open XML format)

Before Office 2007 was released, every Office program stored its
information on the hard disk in a completely different way. These
incompatible formats are called binary formats. This made it very difficult
to write applications that could be used together.

All of this has changed with the new file format that was first introduced
in Office 2007: Office Open XML.

Microsoft have published exactly how this format works and given it
away free to the world’s developer community. This allows other
programs to easily work with Excel workbook files. For example, Apple’s
iPhone supports Office Open XML Email attachments.

Unfortunately, the future has to co-exist with the past and there are still
some people in the world (though a rapidly declining number) using pre-
2007 versions of Office (97, 2000, 2002, 2003 and 2004). If you save your
files in the Open XML format, only people running Office
2007/2008/2010/2011/2013/2016/2019 will be able to read them (but see the
sidebar on the facing page for two potential solutions to this problem).

Excel Macro-Enabled Workbook

An Excel Macro-Enabled Workbook is simply a workbook that has
program code (called VBA code) embedded within it. Macros are beyond
the scope of this book but are covered in the Excel Expert Skills book in
this series.

While macro code is very powerful it can also be destructive, as it is
extremely simple to write damaging viruses within Excel macro code.

Macro programming (also called VBA programming) is a vast subject of
its own and is not useful to the vast majority of Excel users.
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note

How users of earlier
office versions can
read your Open XML
files

Microsoft has a free download:
Open XML File Format Converter
for Mac.

If users of Excel 2004 or earlier
install this, they will be able to
convert Open XML format
documents into the old 97-2004
workbook format.

Alternatively, you can choose
to save your files in the 97-2004
format if you need to allow
users of older versions to open
them.

note

Sharing files using
Cloud Computing
features

You should be aware that Excel
2019 provides another way to
share files with users that do
not have any version of Excel
installed upon their computer.
This is done using Excel 2019’s
built in Cloud Computing
features.

Cloud Computing also allows
users to open (and even edit)
Excel workbooks using devices
such as iPads, Android pads,
Apple Macs and Smartphones.

If you progress to the Essential
Skills book in this series, you'll
find an entire session devoted

to this subject in: Session Eight:
Cloud Computing.

Versions of Excel before Excel 2007 could potentially allow a workbook to
infect your machine with a macro virus because all Excel files were
capable of carrying macros. Because the formats are now separate, it is
easier to avoid opening potentially infected files.

Excel 97-2004 Workbook

This is the old binary format that allows users with earlier versions of
Excel to open your workbooks. Some features won’'t work in earlier
versions and if you've used those in your workbook, Excel will display a
warning when you save telling you which features will be lost.

Excel Binary Workbook

An oddity in Excel 2007/2008/2010/2011/2013/2016/2019 is a binary format
called: Excel Binary Workbook. This is a binary alternative to Open XML
but it can’t be read by earlier versions of Excel. The only advantage of
this format is that it loads and saves more quickly than Open XML. You
will only notice a speed difference when working with very large
worksheets.

PDF

If you need to send a worksheet to a user who does not own a copy of
Excel, you can save it in PDF (Portable Document Format). This format
was invented by Adobe and is also sometimes called Adobe Acrobat or
simply Acrobat.

All major web browsers can open and display PDF files. In macOS (the
operating system used by Apple computers), PDF files will, by default,
open using Preview. If you send a user a PDF file you can be confident
that they will be able to read and print (but not change) the worksheet.

Other formats

As you can see, there are several other less commonly used formats
supported by Excel 2019, but the above formats are the only ones you'll
normally encounter. The most important thing to remember is that,
unless there’s a good reason to use a different format, you should always
save documents in the default Excel Workbook format.

© 2019 The Smart Method® Ltd
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Lesson 1-10: Pin a workbook
and understand file
organization

1 Close down and restart Excel.
2 Pin a workbook to the Recent Workbooks list.
1. Click Recent in the left-hand menu bar.

A list of recently opened documents appears in the right-hand
pane.

The list begins with the most recently opened workbook
(probably the Wealth of Nations Copy workbook saved in: Lesson
1-8: Save a workbook).

Today

s The Wealth Of Nations Copy
» The Wealth Of Nations
ua Macintosh HD » Users » m

2. Move the mouse cursor to the right of one of the files in the
Recent list:

The Wealth Of Nations <>
m@ Macintosh HD » Users » mikesmart » Documents » AllSessions?019Essential » Session 1 A

Notice that a pin icon || has appeared next to the workbook
name.

‘Pinning” a workbook can be a great time saver, as it enables
any workbook that you use a lot to always be shown in the
Recent Workbooks list. You won't have to waste time looking for
them on the hard drive.

You can also view all pinned documents by clicking the Pinned
button above the list of recent documents.

£ B

All

3. Click one of the pin icons. The item moves to the top of the list
and a pin icon appears next to it.

Today
. The Wealth Of Nations
B2 1ocinton 1o o Lovre
~ The Wealth Of Nations Copy

4. Double click on The Wealth of Nations to open the workbook.
3 Understand file organization.

By default, Excel saves all workbooks into your Documents folder
along with other Office documents (such as Word and PowerPoint

e e —

The Wealth of Nations ]
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note

How do | create a
subfolder?

The concept of folders,
subfolders and files is a very
fundamental macOS (or OS X)
skill rather than an Excel skill.

If you do not have basic macOS
skills (an understanding of how
your Mac organizes files) you
would get good value from a
macOS book to give you the
foundation skills you need to
use any Mac program.

Here’s how you create a new
subfolder:

1. Use Finder to navigate to
your Documents folder.

2. Click: @>File>New Folder.

A new folder will appear called
untitled folder.

3. You will now be able to type:
Excel in order to name the
folder.

If this doesn’t work for you,
click the new folder and click:
&> File>Rename. You'll then
be able to type: Excel to rename
the folder.

files). This clearly is going to cause problems when you have a few
hundred files.

It is better to organize yourself from the start by setting up an
orderly filing system.

Create an Excel subfolder beneath your Documents folder.

I create a folder called Excel beneath the Documents folder. In this
folder I create subfolders to store my work. You can see a
screenshot of my Excel folder below (of course, your needs will be
different to mine).

v

vvvvvvvvvvvvvvvvvvvvv|"'

| Excel

] Accommodation

1] Accounts

Bank Reconciliations
| Bank Statements
Book Publishing
Budgets

Business and employment
Cars and motorcycles
Credit Cards
Currency

Diet

Inflation Figures RPI RPIX
Insurance
Miscellaneous

" Personal

Recipes

Stationery Orders
Taxes

Training

Travel

Tutorials

_I,_

44 dqd

_,_
o N

444

See sidebar if you don’t know how to create a subfolder.
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note

Changing the default
number of
worksheets created in
new workbooks

When you open a new blank
workbook in Excel 2019, one
new worksheet is automatically
created called Sheet1.

In some older versions of Excel
(such as Excel 2010 for
Windows), three worksheets
were created called Sheet1,
Sheet2 and Sheet3.

My opinion is that this is a
change for the better, as it
keeps things neater. Most of my
workbooks only need one
worksheet.

But if you long for the “good

old days” here’s how you can
make Excel 2019 mimic Excel
2010 (and earlier versions) at

start-up:

1. Click:
&> Excel>Preferences
2. Click General.

3. Enter the number of sheets
required in the Sheets in new
workbooks box:

Sheets in new workbooks: 3 2

- T =

The Wealth of Nations ]

Lesson 1-11: View, move, add,
rename, delete and navigate
worksheet tabs

When you save an Excel file onto your hard disk, you are saving a single
workbook containing one or more worksheets. You can add as many
worksheets as you need to a workbook.

There are two types of worksheet. Regular worksheets contain cells.
Chart sheets, as you would expect, each contain a single chart. If you
progress to the Essential Skills course in this series, you'll learn everything
there is to know about charts in: Session Five: Charts and Graphics.

1 Open The Wealth of Nations from your sample files folder (if
it isn’t already open).

2  Move between worksheets.
Look at the tabs in the bottom left corner of your screen. Notice

that this sample workbook contains three worksheets. Click on
each tab in turn to view each worksheet.

| GDP Life Expectancy = Mobile Phones +

3  Add a new worksheet.
1. Click the New Sheet button (the plus sign next to Mobile Phones).

A new tab appears named Sheet1.
2. Double-click the Sheet1 tab.

3. Type the word Population followed by the <Enter> key.

| GDP Population Life Expectancy Mobile Phones + ‘

4 Move a worksheet's tab.
1. Click on the Population tab (you may have to do this twice).

2. Hold the mouse button down and drag to the left or right. As
you drag, you'll notice an icon of a page and a black arrow
showing you where the tab will be placed.

3. Release the mouse button to move the tab to the location of
your choice.

. R
GDP Population Life Expectancy Wobile Phones +

5 Understand the tab scroll buttons

Click
Left one tab

| Right one tab
I
<« »
<Cmd> + Click
I— Scroll to last tab
Scroll to first tab
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note

Right clicking in
macOS

Many of Excel’s features are
easier to access if you have two
mouse buttons.

You can see how to configure
your mouse to work this way
in: Lesson 1-1: Configure your
mouse and understand right
clicking.

To work through the course
with only one mouse button,
use <Ctrl>+Click whenever you
are instructed to right click.

tip
Alternative ways to
do the same thing

Excel often offers more than
one way to execute the same
command.

As well as using the right-click
menu, you can also delete a
workbook by using:

&> Edit>Sheet>Delete Sheet.

Yet another way to delete a
worksheet is to use the Ribbon
command:

Home—>Cells>Delete>
Delete Sheet

You can close a workbook
without using the Menu Bar by
using the <Cmd>+<W>
keyboard shortcut or the red
Close button.

[®]

Because this workbook only has four tabs, there’s no need to use
the tab scroll buttons (in fact, they don’t do anything when all tabs
are visible). When there are more tabs than will fit on the screen,
the tab scroll buttons are used to move between tabs.

Move between worksheets using the keyboard.

You can move between worksheets using only the keyboard by
pressing the <Cmd>+<PgUp> (¥) and <Cmd>+<PgDn> (%)
keyboard shortcuts to cycle through all of the tabs in your
workbook.

Change tab colors.

1. Right click any of the worksheet tabs. A shortcut menu
appears.

If you don’t have a mouse with two buttons, <Ctrl>+Click will
have the same effect (see sidebar).

2. Move the mouse cursor to Tab Color and choose any color.

It is best practice to choose a color from the top block of Theme
Colors rather than one of the Standard Colors.

If you progress to the Essential Skills course in this series you'll
learn to use Themes and will then understand why the use of
theme colors is best practice.

3. Repeat for the other tabs on the worksheet.
Delete a worksheet.

Right click on the Population tab and select Delete from the shortcut
menu.

Delete several worksheets at the same time.
1. Hold down the <Cmd> key.

2. Click each tab you want to delete in turn. Don’t select them all
as it isn’t possible to delete every worksheet in a workbook.

3. Right click any of the selected tabs and select Delete from the
shortcut menu.

4. Click Delete when prompted.

Don’t worry about the missing tabs. You're going to close the
workbook without saving it, so you won’t overwrite the original
workbook.

10 Close the workbook without saving it.

1. Click: @>File=>Close.

A dialog is displayed:
- Want to save your changes to 'The Wealth Of
— Nations.xlsx'?
= Your changes will be lost if you don't save them.
Don't Save Cancel ﬁ

2. Click Don’t Save so that you don’t over-write the workbook.

Because you haven’t saved the workbook it will remain in its
original state when you next open it.

© 2019 The Smart Method® Ltd
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important

The Ribbon shows
more if you have a
wider screen

When I work with Excel I use a
22-inch widescreen monitor
running at 1,600*900 pixels.

Excel uses all of the available
screen space to display
extended descriptions of each
feature on the Ribbon.

For example, the Styles pane on
the Home Ribbon shows six
buttons for ten common cell
styles, allowing them to be
applied with a single click
rather than two clicks.

Lesson 1-12: Use the Ribbon

The Ribbon provides fast access to hundreds of Excel features.

The sheer breadth of Excel features can seem overwhelming. This book
will gently introduce all of the most important features, one at a time.

By the end of the book you'll be really comfortable and productive with
the Ribbon.

1 Start Excel and open a new blank workbook.

You learned how to do this in: Lesson 1-2: Start Excel and open a new
blank workbook.

2  Use Ribbon tabs.

Each Ribbon tab has its own toolkit available to you. By far the
most important tab is the Home tab which has buttons for all of the
most common and useful features.

Click each tab in turn and view the buttons. The screenshot below
has the Insert tab selected. Don’t worry if the buttons seem cryptic
at the moment. Most of them will make complete sense by the end
of this book (and if you later go on to complete the Expert Skills
course, Excel will have no mysteries left at all).

Quick Access Toolbar Ribbon Ribbon Tabs Formula Bar
g - ¥
Insert Page Layout  Formulas  Data &t Share A
vy 53 . . [ 5 o . + . .
3 & i e gy w 7 4 Q
Tables liustrations Add-ins Recommended - h * Maps PivotChart  Sparklines meline Link . Text Symbols
Charts D L ComiMiggt
Charts Sparklines Filters Links Comment
Al . f v
A B C D E F G H ] J K L M N
3 Display Ribbon group names.
note The Ribbon is divided into several groups of icons. Each group has

Contextual tabs

Sometimes Excel will show you
even more tabs.

If you progress to the Essential
Skills book in this series, you'll
learn everything there is to
know about charts in: Session
Five: Chars and Graphics.

When you click on a chart a
new tab called Chart Tools
appears.

The new tab provides access to
a range of features relating to
Charts.

View Chart Design Format

its own name, but these names are hidden by default. Displaying
the group names makes it much easier to find what you are
looking for.

1. Click: @->Excel>Preferences.
The Excel Preferences dialog appears.
2. Click View.
3. Inthe In Ribbon, Show group, click Group Titles.

In Ribbon, Show

Developer tab
Group Titles

4. Close the Excel Preferences dialog.

4 Type the word Test into any blank cell and then press the
<Enter> key on the keyboard once.

Notice how the Active Cell moves to the cell beneath.

40

https://TheSmartMethod.com




Session One: Basic Skills

important

If your Ribbon doesn’t
look like the
illustrations in this
book

Remember that the Ribbon will
look different depending upon
the size of your screen (see
important sidebar on previous
page) but all of the features will
still be there.

Your Ribbon may also look
different if you are using Excel
365 (the subscription version of
Excel) rather than Excel 2019, as
some new features may have
been added to Excel 365 since
Excel 2019 was released.

Make the cell with the word Test into the active cell.

Click once on the word Test or use the arrow keys on the keyboard
to navigate back to the cell. Be very careful not to double-click,
otherwise Excel will think that you want to edit the cell.

A B
1
2 Test
3 | 1
A
5
A B
1
2 | [Test 1
6

Click the Home tab on the Ribbon and focus upon the Font

group (it's the second panel from the left). Try clicking each
of the buttons and you will see the word Test change to

reflect your choices.

This drop-down allows you to
change the font to something
different to the default Calibri.

Calibri (Body)

B I

Click here once to make the ]

text Bold, Italic or Underlined
(or all three). Click again to
restore it to Normal.

This drop-down arrow allows

you to add a double underline.

H R

12 + A=~ A- These buttons allow you to
n change the cell's background
|_ N " & " | and text colour.

This drop-down allows you
to change the size of the
font (measured in points).

Clicking here puts a single
underline along the entire
length of the bottom of the
cell. Try the drop-down arrow
too for more border options.

7  Minimize the Ribbon.

Click a second time on the Home Ribbon tab.

Notice how the Ribbon is now minimized in order to save screen

space (though the Formula Bar is still visible).

o N«
Home Insert

Al v

Page Layout

S

Formulas

You can always minimize the Ribbon by clicking a second time on

the currently selected tab.

8  Bring back the Ribbon.
Click on any tab to bring back the Ribbon.

9 Close Excel without saving changes.

1. Click: 6>File>Close or click the red cross [®]in the top left

corner.

2. When asked if you want to save your changes, click the Don’t

Save button.

© 2019 The Smart Method® Ltd
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Lesson 1-13: Understand
Ribbon components

The whole is more than the sum of its parts.
Aristotle, Greek critic, philosopher, physicist & zoologist
(384 BC - 322 BC)

The Ribbon is made up of several different controls.

Command group

General

aBlxl% ] o || %31 Similar actions are grouped into a cluster. For example, every control
relating to numbers is clustered into the Number group.

Number

g | Normal button

Simply executes a command when clicked. The Bold button on the Home
tab is a good example.

Menu button
GHEm .

This type of button has a little down-arrow on it. It will display a drop-
down menu when clicked.

Insert

v -| Split button

This is the hardest button to understand because these buttons look
almost the same as the Menu button. When you hover the mouse cursor
over a split button, the icon and drop-down arrow highlight separately as
different “buttons within a button”.

Ji& Il Alls A good example is the Underline button on the Home tab.

—_ ==
Clicking the icon part of a split button (the U) will perform the default
action of the button (in this case a single underline). Clicking the arrow
Double Underline part of the button will display a drop-down list of further choices (in this
case the choice between a single and double underline).

U -

= &
U Underline
D

o o (0 24 Drop down list
¢ — L F
= Insert Cells... I often shorten this to simply “Drop Down” in this book. A drop down is

a simple menu listing several choices.
#= Insert Sheet Rows

= If you see an ellipsis (...) after a drop down list item, this means that a
‘g Insert Sheet Columns

dialog will be displayed after you click, offering further choices.

¢ Insert Sheet
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Drop down gallery

This is a little like a drop-down list but has graphics to visually
demonstrate the effect of each choice.

141 z v
[ 7v| 4mm., mmX, v A,
pﬁ/;_ HH - E = ok Z?
Good, Bad and Neutral

Normal | Bad Good Neutral

Data and Model

Calculation tCell Explanatory Linked Ce Note

Gridlines Headings
v view V| View

Print Print

Sheet Options

Check box

A little square box that you can click to switch an option on or off.

In this example (from the Page Layout Ribbon tab) you are able to switch
the gridlines on and off for the screen display and/or the printout.

© 2019 The Smart Method® Ltd
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Lesson 1-14: Customize the
Quick Access Toolbar and
preview the printout

You can customize the Quick Access Toolbar to suit your own special
requirements. In this lesson, you'll add some useful buttons to the Quick
Access Toolbar to save a few clicks when accessing common commands.

The Quick Access Toolbar is one of the keys to being really productive with
Excel. This lesson will introduce you to the main features.

1 Open The Wealth of Nations from your sample files folder.

2 Preview how the Life Expectancy worksheet will look when
printed.

1. Click the Life Expectancy tab at the bottom of the worksheet.
2. Click: @>File>Print.
The Print dialog appears.

The Print dialog displays a huge number of print-related
features. A preview of how the page will look when it is
printed is displayed on the left-hand side of the dialog.

3. Click the Next Page and Previous Page buttons to move through
the print preview.

Notice there’s a button to the bottom-left of the preview pane
that allows you to cycle through each page:

Next and
:=previous page:
:=— buttons =

10f 10 > >

4. Click the Cancel button at the bottom right of the dialog to
return to the workbook.

Customize Quick
Access Toolbar | 3 Add a Print button to the Quick Access Toolbar.

Button

Printing is a very useful feature and you’ll probably use it a lot.
Every time you print, however, it is going to take two clicks of the

O D dEwv- 6~ mouse. Wouldn’t it be better if you could open the Print dialog
[ Home [ G with just one click?
s =N _ 1. Click the Customize Quick Access Toolbar button (see sidebar).
The Wealth of Nations ] 2. Click the Print item in the drop-down list.
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note

Not all Excel
commands can be
added to the Quick
Access Toolbar

Customizing the Quick Access
Toolbar is a relatively new
feature in Excel for Mac and
isn’t quite as comprehensive as
in Excel for Windows.

Many Excel commands cannot
yet be added to the Quick
Access Toolbar, but this can be
expected to change in the
future as Microsoft continue to
release updates.

tip
The Quick Access Toolbar is

one of the keys to being really
productive with Excel 2019.

Always try to minimize the
number of mouse clicks needed
to do common tasks.

If you find yourself forever
changing tabs to use a button,
change two clicks into one by
adding the button to the Quick
Access Toolbar.

All of those extra clicks add up
to a lot of time over the weeks
and years.

A new button now appears on the Quick Access Toolbar. You
are now able to Print your work with a single click of the
mouse.

° B - 8 =~
Formulas

Add a Copy button to the Quick Access Toolbar.

Page Layout

A More Commands... option is available when you click the
Customize Quick Access Toolbar button. This enables you to add any
of Excel’s commands to the toolbar.

1. Click the Customize Quick Access Toolbar button.
2. Click the More Commands... item in the dropdown list.

A dialog appears, showing all of Excel’s available commands
on the left and the commands on the Quick Access Toolbar on
the right.

3. Click Copy in the left-hand pane of the dialog.
4. Click the right arrow in the middle of the dialog.

Choose commands from:

Popular Commands B . .
Customize Quick Access Toolbar:
Y Add or Remove Filters i File
__ Borders » k- Save
= Calculate Now %Y Undo »
= Center Text (J Repeat
I Conditional Formatting » & Print
| #Copy |

t+ Custom Sort...
X cut
A~ Decrease Font Size 5 N
s=x Delete Cells...

!, Delete Sheet Columns
=+ Delete Sheet Rows

5. Click Save.
A Copy button is added to the Quick Access Toolbar.

o ME w8 & ~

Page Layout Formulas

Remove the Copy button from the Quick Access Toolbar.

1. Click the Customize Quick Access Toolbar button and click More
Commands from the dropdown list.

2. Click Copy in the right-hand pane of the dialog and then click
the left arrow button in the middle of the dialog.

3. Click Save.

© 2019 The Smart Method® Ltd
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note

Page Break Preview
is only available in
Excel 365

The Page Break Preview feature
has been added to Excel for Mac
since it was first released.

New feature updates are only
provided to Excel 365 users, so
this option will not be available
if you are not using Excel 365.

If you are using Excel 365 and
still don’t have this feature, you
just need to update to the latest
version.

You saw how to update Excel
in: Lesson 1-3: Check that your
Excel version is up to date.

= N _
’fThe Wealth of Nations ]

Lesson 1-15: Understand
views

Views provide different ways to look at your worksheet.
Excel 2019 has three main views. They are:

View Icon What it is used for

Normal

This is the view you’ve been using until
now. It's the view most users use all of the
time when they are working with Excel.

Page Layout

This view allows you to see (almost)
exactly what the printout will look like.

Unlike running a Print Preview, you are
able to edit cells just as you can in Normal
view.

Page Break
Preview A

1

A page break indicates when the printer
should advance onto a new sheet of paper.

If you progress to the Essential Skills
course in this series, you'll use this view in:
Lesson 7 5: Insert, delete and preview page
breaks, to make sure that the page breaks in
the right place.

Open the Wealth of Nations sample workbook (if it isn’t
already open).

® O da O = il The Wealth Of Nations Q. ©-

Insert Page Layout Formulas Data Review View &t Share -
@ X A — cy || Conditional Formatting »  14=1
2 .=, . =ik Q z
u—\ = e - 0o ' Format as Table ~
Paste i Font Alignment  Number Cells Editing
y o Cell Styles =
Clipboard Styles
Al . fi Rank
A B c ] E F G
1 |Rank Icountry GODP - per capita (PPP)  Date of information
2 1 Qatar $137.200 2014 est.
3 2 Luxembourg $97.600 2014 est.
4 3 Liechtenstein $89,400 2009 est.
5 4 Macau $88,700 2013 est.
6 5 Bermuda $85,700 2013 est.
7 & lsle of Man $83,100 2007 est.
4 » GDP Life Expectancy Mobile Phones +
Ready 1T o @ = — + 100%
View Buttons

You can change views in two ways:

1. By clicking one of the View buttons at the bottom of the
window (see above).

2. By clicking one of the buttons on the Ribbon’s View tab (see

below).
] Bl

Normal Page Break Page Custom
Preview Layout Views
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View the GDP worksheet in Page Layout view.
1. Click on the GDP tab.

2. Select Page Layout view by clicking:
View->Workbook Views—>Page Layout.

= & @O

Normal Page Break Page Custom
Preview Layout Views

1 2 3 4 5
A B c
1 l Rank .l:ounw GDP - per capita (PPP)
1 Qatar $137,200
3 2 Luxembourg 597,600

The worksheet is displayed in Page Layout view. You are able to see
(almost) exactly what will be printed. Headers, footers and
margins are all shown.

You are also able to edit the worksheet.

You may wonder why Excel users don’t use Page Layout view all of
the time when editing worksheets. While some users may prefer to
do this, most will want to see the maximum amount of data
possible on screen and so will prefer the Normal view.

3 Select Page Break Preview view.

Click: View—>Workbook Views—>Page Break Preview.
The worksheet is displayed in Page Break Preview view.

This view zooms out, showing the breaks between pages as blue
dotted lines:

It is possible to click and drag the dotted lines to change the place
where the page breaks.

4  Return to Normal view.

Click: View—>Workbook Views=>Normal.

© 2019 The Smart Method® Ltd
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/_- = ) S

The Wealth of Nations ]

Lesson 1-16: Hide and Show
the Formula Bar and Ribbon

Most desktop computers have large display screens. The space taken by
the Ribbon and Formula Bar isn’t usually a problem.

If you progress to the Essential Skills course in this series, you'll discover
in: Session Eight: Cloud Computing that it is now possible to run Excel 2019
on tablet computers (and even on Smartphones). These devices often
have a very small display screen, meaning that the ribbon and Formula
Bar take up too much valuable screen space.

When screen space is limited, you may wish to hide the Formula Bar,
Ribbon, or even both, in order to maximize the number of cells visible on

the screen.

1 Open The Wealth of Nations from your sample files folder (if
it isn’t already open) and click the Life Expectancy tab.

Notice that the Ribbon and Formula Bar are taking up space that

could be used to display the contents of the worksheet.

Consider the screen below:

Formula Bar

Ribbon

® i}

Home Insert rage Layout

oo o» 7]

Formulz s

Data >

a @ p
- -
View Record

findow

Views Macros Macro
Zow Macros
Al . fx Rank v
A B c o

1 |Rank .Cnullw GODP - per capita (PPP) Date of information '
2 1 Qatar $137.200 2014 est.
3 2 Luxembourg 597,600 2014 est.
4 3 Liechtenstein $89,400 2009 est.
5 | CEEANMASCSU $88,700 2013 est.

4 » GDP Life Expectancy =~ Mobile Phones +

Ready 1T N D @B - — 4 100%

This is the type of smaller screen that you might see on a small
tablet device or Smartphone.

Only five rows are visible, making the worksheet difficult to work
with. Hiding the Ribbon, Formula Bar, or both, will free up some
valuable screen space.

Hide the Formula Bar.
Click: View>Show—=>Formula Bar.

The Formula Bar vanishes:

] mgag v~ » @ Q- ©-
Home Insert Page Layout Formulas Data > &t Share -~
Y .  Zoom 100% vl [ P ep
== — -/ e
Workbook  Show @& zoom 10 100% Window  View Record
Views Macros Macro
Zoom Macros
A 8 C D
1 [Rank ICountry GDP - per capita (PPP) Date of information
2 1 Qatar $137,200 2014 est.
4 p GDP Life Expectancy Mobile Phones +
Ready 1T N [ - — 100%
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4 »

Reduce the Ribbon display to only show tabs.

In: Lesson 1-12: Use the Ribbon, you learned how to hide the Ribbon
by clicking the selected Ribbon tab a second time.

You can now see as much of the worksheet as possible, which can
be very useful on smaller screens.

e] M Ed wv- »

Home Insert  Page Layout

A B

Rank .C.ountry

1 Qatar

2 Luxembourg

3 Liechtenstein

4 Macau

5 Bermuda

6 Isle of Man

7 Singapore

8 Brunei

9 Monaco

10 Kuwait

~ GDP
Ready Il'

Life Expectancy

El o

3 a- ©-
Formulas Data » at Share v
C D

GDP - per capita (PPP) Date of information
$137,200 2014 est.
$97,600 2014 est.
$89,400 2009 est.
588,700 2013 est.
$85,700 2013 est.
$83,100 2007 est.
$83,100 2014 est.
$79,900 2014 est.
$78,700 2013 est.
$70,700 2014 est.

Mobile Phones +

- + 100%

3

Restore the Ribbon and the Formula Bar.

1. Click any of the Ribbon tabs.
The Ribbon is restored.
2. Click: View—>Show—=>Formula Bar.

The Formula Bar is restored.

M Edwov- »
Insert Page Layout
-
Workbook  Show @, zoom t0100%
Views
Zoom
Al . fx Rank
A B
1 |Rank .Cmntrv
2 1 Qatar
3 2 Luxembourg
4 3 Liechtenstein
5 4 Macau
4 » GDP Life Expectancy
ety @

®-

&t Share A

g Q-

Formulas Data >

. _— . _. -._r
| L =

Window View Record

Macros Macro

Macros
A4
C D
GDP - per capita (PPP) Date of information
$137,200 2014 est.
597,600 2014 est.
$89,400 2009 est.
588,700 2013 est.
Mobile Phones +
- — + 100%
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note

The screenshots
shown in this lesson
may differ from those
you see on your
screen

The Excel 2019 help system is
delivered online. This means
that Microsoft are able to
constantly correct and update
help topics.

For this reason, the information
you see on your screen may
differ from the screenshots
shown in this lesson.

e e

The Wealth of Nations ]

Lesson 1-17: Use the help
search system

Excel 2019 for Mac not only provides information about Excel features,
but also enables you to execute Ribbon commands directly from inside
the help system. This can be a huge time saver.

1 Open the Wealth of Nations from your sample files folder (if it
isn’t already open).

2 Click «>Help and click inside the Search box.

Search |

Excel Help
What's New

Check for Updates

When you click inside the Search box, a flashing cursor appears
and you are able to type a question.

3 Ask Excel how you can save a file.

You learned how to save a file in: Lesson 1-8: Save a workbook to a
local file. In that lesson you clicked the Save button on the Quick
Access Toolbar.

Imagine that you have forgotten how to save a file.

Type Save into the Search box.

Search Save (]

Excel displays a menu of choices, showing every command that
contains the word Save.

Search  Save [x]

Menu items :W—‘ . I Excel commands
Ve AS...
— Save as Template... (these can be exe.:Uted dlrec'IY)

Help Topics @ GetHelpon Save weeess—s= Regular online help topics

Notice that the list is delineated into two sections. The first section
contains commands. The second has the type of regular help topics
that you are used to reading in traditional help systems.

4 Execute the Save command directly from the search.

Click the Save command at the top of the menu:

In a traditional help system, you would have expected to see some
text explaining how the Save command works. Instead the
command is executed immediately. The workbook is saved in
exactly the same way it would have been if you had clicked the
Save button on the Quick Access Toolbar.
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note

You need an Internet
connection to use
Excel 2019’s help
features

In previous versions of Excel, it
was possible to access offline
help when no Internet
connection was available.

Support for offline help has
been dropped from Excel 2019.
If you have no Internet
connection, you will not be able
to access Excel’s help features.

You can see that two other commands are also available:

e  Save As. You learned how to use the Save As command in:
Lesson 1-8: Save a workbook to a local file.

e Save As Template. Templates are not covered in this Basic
Skills book. The Essential Skills book in this series covers the
Templates feature in depth (in Session Three: Taking Your
Skills to the Next Level).

You can see how useful help search is when you can’t remember
where a command is situated on the Ribbon and want to execute
the command as quickly as possible.

You can also see that it could be dangerous to execute commands
that you don’t understand.

Fortunately, Excel also offers regular help that you can read as a
reference.

Read the Excel help topics relating to the Save command.
Click: @->Help—>Get Help on Save.

Search

Menultems — Save
T Save As...
— Save as Template...

Help Topics *B Get Help on save

Links to several topics from the Excel 2019 reference manual are
shown. You can click on any of these links to read Microsoft’s own
help topics about Save related features.

[ NON ) Excel Help

o Save (<]

Excel for Mac Help

Save a custom chart as a template

Save a custom chart as a template. ... If you want to reuse a chart
that you created, you can save the chart as a template in Excel, and
then apply it to a new or existing chart in Word, PowerPoint, or
Excel. A chart template that you create is actually a custom chart
type that you can apply as you would any other chart type.

Create and save all your macros in a single workbook ...
Create and save all your macros in a single workbook by creating
them in Personal.xisb, a hidden workbook that opens every time you
open Excel. Macros created in Personal.xlsb are available every time
you open a workbook in Excel.

Save a workbook as a webpage
You can save a whole workbook, including tabs to move between

e et W P e e o s el e B e R e R e

Note that you must be connected to the Internet in order to view
the Excel help topics (see sidebar).

© 2019 The Smart Method® Ltd
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In this exercise you'll try to remember the name of each of the Excel screen elements. The answers are on the
next page, so you might want to recap by turning the page for a little revision before you start.

Keep trying until you are able to name each of the screen elements from memory. You'll be seeing this
terminology during the remainder of the book, so it's important that you can correctly identify each element.

1 I | Workbook3 ®-
Insert Page Layout For nulas Data Review View =t Share ~
- =1 = i T
| A . X Calibri (Body) ~+ 12 A~ Av = =2 General = || Conditional Formatting gy .
i’ i = == ; ; =
A s = = = . — &' Format as Table o o
Past . v | B lv v v ! )
aste & B |ILI |V e - = 9= P = % ) % e 7 Cell Styles + s ing
Clipboard Font Algnment Number Styles
a v fx M
B C D E F G H 1 J K L M N 0
1
2
5| ——0Q
4
5
6
. O
8

l El T = — +  100%
o (L) |
o 00 O
If you need help
slide the page to
the left
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Ribbon
Close, Minimize and Zoom buttons

Quick Access Toolbar
Formula Bar

15 B | L

Insert Page Layout
U"ﬂ v ‘x’ Calibri (Body) =~ 12

Paste ; B I
&

For nulas Data

o

o

U - - P
Clipboard Font

f

a3 .

8
5
8

0~ B W N e

Column
Title Bar Header
Workbook3
View

Ganeral = = Conditional Formatting ~

&% )

Number

=

') Format as Table

o Cell Styles ~
Styles

setl +

2

— —

Elo m -

100%

Sheet Tab
Row Header

New Sheet
button

Tab Scroll buttons

Scroll Bars View buttons
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Session Two: Doing Useful
Work with Excel

Only those who have the patience to do simple things perfectly ever
acquire the skill to do difficult things easily.

Unknown author

Now that you've mastered the basics, you are ready to do really useful
work with this amazing tool. In this session you will learn to use all of
Excel’s basic features properly. This will put you way ahead of anybody
that hasn’t been formally trained in Excel best practice. You'll be doing
simple things, but you'll be doing them perfectly!

Even after years of daily use, many users are unable to properly use
Excel’s fundamental features. They often reach their goal, but get there in
a very inefficient way, simply because they were never taught how to do
things correctly. By the end of this session you’ll be astonished with how
well you are working with Excel.

Session Objectives

By the end of this session you will be able to:

Enter text and numbers into a worksheet

Create a new workbook and view two workbooks at the same time
Use AutoSum to quickly calculate totals

Select a range of cells and understand Smart Tags

Enter data into a range and copy data across a range

Select adjacent and non-adjacent rows and columns

Select non-contiguous cell ranges and view summary information
AutoSelect a range of cells

Re-size rows and columns

Use AutoSum to sum a non-contiguous range

Use AutoSum to quickly calculate averages

Create your own formulas

Create functions using Formula AutoComplete

Use AutoFill for text and numeric series

Use AutoFill to adjust formulas

Use AutoFill options

Speed up your AutoFills and create a custom fill series
Understand linear and exponential series

Use Flash Fill to split and concatenate text

Use the zoom control

Print out a worksheet

© 2018 The Smart Method® Ltd
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tip
Entering numbers as
text

Sometimes you need Excel to
recognize a number as text.

If you type an apostrophe (*)
before the number, Excel won't
display the apostrophe but will
format the cell as text. You'll
notice that the number is then
left justified to reflect this.

When a number is formatted as
text you cannot perform any
mathematical calculations with

it.

First Quarter Sales and
Profit

Lesson 2-1: Enter text and
numbers into a worksheet

Excel beginners tend to reach for the mouse far too often. One of the keys
to productivity with Excel is to avoid using the mouse when entering
data. In this lesson you’ll quickly populate a worksheet without using the
mouse at all.

1 Open the sample file: First Quarter Sales and Profit.

A B C D
1 Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar
4 New York 22,000 25,000 19,000
5 Los Angeles
6 London
7 |Paris
8 | Munich

2 Notice the difference between values and text.

Cells can contain values or text. Values can be numbers, dates or
formulas (more on formulas later).

Excel usually does a great job of recognizing when there are values
in a cell and when there is text. The giveaway is that text is always
(by default) left aligned in the cell and values are right aligned.

Look at the numbers on this worksheet. Notice how they are all
right aligned. This lets you know that Excel has correctly
recognized them as values and will happily perform mathematical
operations using them.

3 Save a value into a cell.

1. Type the value 42000 into cell B5. Notice that the mouse cursor
is still flashing in the cell.

42000

At this stage the value has not been saved into the cell.

If you change your mind, you can still undo the value by
pressing the <ESC> key at the top left of your keyboard or by

clicking the Cancel button L1 on the left-hand side of the
Formula Bar.

2. Decide that you want to keep this value in the cell by either
pressing the <Enter>, <Tab> or an <Arrow>kﬁ on the

keyboard, or by clicking the Confirm button ¥ Jon the left-

hand side of the Formula Bar.
4 Enter a column of data without using the mouse.

When you enter data into a column, there’s no need to use the
mouse. Press the <Enter> key after each entry and the active cell
moves to the cell beneath. Try this now with the following January
sales data:
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important

The many ways of
entering numbers

Negative numbers

-123.56
(123.56)

Currency prefixes

Excel is quite happy for you to
prefix a number with a currency
symbol. The currency symbol it
will accept depends upon how
you defined the regional options
in your operating system.

$123.56 (works in USA)
£123.56 (works in UK)

If you progress to the Essential
Skills book in this series, you'll
learn an easy method of setting
$, £ and € currency prefixes
whatever your locale in: Session
Four: Making Your Worksheets
Look Professional.

Commas

12,234,567.78

Fractions

You must leave a space between
a number and a fraction for this
to work.

61/4
(six, space, one, /, four)

The above will appear on the
worksheet as 6.25 after you
enter it in this way.

01/4
(zero, space, one,/,four)

The above will appear on the
worksheet as 0.25. The leading
zero is needed to prevent Excel
from assuming that you are
entering a date.

1. Type 18,000 into cell Bé.
2. Press the <Enter> key to move to cell B7.

3. Do the same to enter the following values into the next two

cells.
A B C D
1 Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar
4 New York 22,000 25,000 15,000
5 Los Angeles 42,000
6 London 18,000
7 |Paris 35,000
8 Munich 12,000

Enter a row of data without using the mouse.

You can also enter a row of data without using the mouse.
1. Click in cell C5.

2. Type 39,000 and then press the <Tab> (=) key.

The <Tab> key is on the left-hand side of the keyboard above
the <Caps Lock> key. Notice how pressing the <T'ab> key saves
the value into the cell and then moves one cell to the right.

3. Type 43,000 into cell D5 and press the <Enter> key.

You magically move to cell C6, as Excel assumes that you want
to begin entering data into the next row.

Complete the table without using the mouse.

By using the <Tab> or <Enter> key in the right place you should be
able to complete the table now without using the mouse:

A B C D
1 Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar
4 New York 22,000 29,000 19,000
5 Los Angeles 42,000 39,000 43,000
6 London 18,000 20,000 22,000
7 Paris 35,000 26,000 31,000
8 | Munich 12,000 15,000 13,000

Formula Bar

fx January

B L
fit Report - First Quarter 2016

| January .I Feb Mar

22,000 29,000

Change the text in cell B3 to January.

1. Double-click cell B3. Notice that there is now a flashing cursor
in the cell.

Jan |
L

2. Type uary on the keyboard to change Jan to January.
3. DPress the <Enter> key.
Change the text in cell B3 back to Jan using the formula bar.

Click once in cell B3 and then change the text in the formula bar
back to Jan (see sidebar).

Save your work as First Quarter Sales and Profit-2.

© 2019 The Smart Method® Ltd
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tip
Other ways of

creating a new
workbook

e  Use the keyboard shortcut
<Cmd>+<N>.

e  (Click the File button on the
Quick Access Toolbar to
return to the Excel start
screen.

See more details of how this is
done in: Lesson 1-2: Start Excel
and open a new blank workbook.

Lesson 2-2: Create a new
workbook and view two
workbooks at the same time

1 Open Excel and create a new blank workbook.
1. Close any open Excel windows and re-open Excel.

2. Double click the Blank Workbook template to create a new
workbook.

Excel helpfully creates a workbook, unimaginatively named
Book1. If you already have a workbook open called Book1, the
new workbook will be called Book2... and so on.

Notice that Book1 is displayed on the Title Bar.

Dd O 8 ¥ Booki Q- ©-
Insert Page Layout Fo’ . ulas Data  Review View &t Share A
= X - — cy [ Conditional Formatting = 14=1 Q
i oo || b — 0 4 Format as Table .
Paste - Font Aligognt Number . Cells Editing
< & Cell Styles ~
Clipboard Styles
Al . v
A B C D E F G H
) —
I 4 » Sheet1 +
| Ready i 0] = c——+ 100%

2 Maximize the window without entering Full Screen view.

Hold the <Alt> key and click the green Zoom button at the top of
the Excel window to maximize the window without entering Full
Screen view.

@]

It’s important that you are not in Full Screen view, as you cannot
view full screen windows side by side. You learned about Full
Screen view in: Lesson 1-6: Understand Full Screen view.

3 Create another new workbook and maximize it.
1. Click: @=>File>New Workbook.

2. A new blank workbook called Book? is displayed in the
workbook window.

3. <Alt>+Click the Zoom button to maximize the window.

You could be forgiven for thinking that nothing has happened
but you can see that the Title Bar now says: Book2, showing that
you are now looking at a different workbook.

Book2

Data Review View

4 Use the Dock to move between workbooks.

Right click the Excel icon on the Dock at the bottom of the screen.
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note

Finding a workbook
when many are open

As well as using the Dock, you
can also switch windows using
the Menu Bar and macOS'’s
Mission Control.

To switch windows with
Excel’s Menu Bar, click

&> Window. You'll then see a
list of all open workbooks and
can click to switch between
them.

To access Mission Control,
press the <F3> key on your
keyboard.

Mission Control allows you to
switch between all open
windows, not just Excel
windows.

Arrange Windows

Tiled

© Horizontal
Vertical
Cascade

Windows of active workbook

A shortcut menu is displayed, showing both Book1 and Book?2.

" Book1
v 1 Book2

Try clicking Book1 and Book2 to switch between them. Both
workbooks are empty so you won't see any difference in the cells,
but you should see the name changing in the Title Bar.

See sidebar for other methods of switching windows.
Display both Book1 and Book2 at the same time.

In order to view two workbooks at the same time, they must not be
in Full Screen view. If either window is in Full Screen view, you
must exit this view using the skills you learned in: Lesson 1-6:
Understand Full Screen view.

1. Click: #>Window->Arrange.
The Arrange Windows dialog is displayed.
2. Choose the Horizontal arrangement and click the OK button.

Both workbooks are now shown, one above the other. Each
window occupies exactly half of your screen:

N g Jd & F Bookl Q- ©-
Insert Page Layout Formulas Data » &t Share A
- A _— [=| Conditional Formatting » 1=
B A = % 3 = Q-
& Format as Table *
Clipboard Font Alignment Number &/ Cell Styles ~ Cells Editing
Styles
-
Al v fx v
A B [ D E F G H
 —
4 » Sheet1 +
+ 100%

Ready i3] 0] = c—

Insert Page Layout Formulas Data >

C- — 0/ Congitional Formatting Id=b1 Q
v . . v m " .
o - o & Format as Table ~
cl Font Ali t Number Cell Edit
ipboard on gnmen umbe = Cell Styles * ells ing
Al . S v
A B C D E F G H
1
2
4 » Sheet1 +
Ready EN {] - c——t 100%

Notice that, as you click each workbook window, the Title Bar
and the Close/Minimize/Zoom buttons light up to show that this
is the active window.

Close Book2 and maximize Book1 to restore the display to a
single workbook.

If you've forgotten how to do this, refer back to Lesson 1-5:
Minimize, re-size, move and close the Excel window and Lesson 1-6:
Understand Full Screen view.

© 2019 The Smart Method® Ltd
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anecdote

I ran an Excel course for a small
company in London a couple of
years ago.

The boss had sent his two office
staff to learn a little more about
Excel.

Before the course began I asked
the delegates how long they had
been using Excel. They told me
that they’d been using it for two
years to do all of their office
reports.

When I showed them AutoSum
they gasped in delight. “This
will save us hours” they told
me.

I was curious how they had
been doing their reports before.

Believe it or not, they had been
adding up all of the figures in
each column with a calculator
and then manually typing the
totals at the bottom of each
column.

In this case the boss had given
them Excel as he had heard it
was very good. Unfortunately,
he had not initially seen the
need to train the staff in its use.

With no training it seemed quite
logical to them to use it like a
word processor and the boss
had still been delighted that his
staff were using such impressive
technology.

First Quarter Sales and
Profit-2

Lesson 2-3: Use AutoSum to
quickly calculate totals

Excel’s AutoSum feature is a really useful and fast way to add the values
in a range of cells together.

1 Open First Quarter Sales and Profit-2 from your sample files

folder.

2 In cell A9, type the word Total followed by the <Tab> key.

The active cell moves to the right and is now in cell B9:

A

7 | Paris
8 Munich
9 |Tola|

B C
35,000 26,000
12,000 15,000

D

31,000
13,000

3 Click: Home—>Editing—>AutoSum

AutoSum

Button

L]
3, AutoSum v
&/ Fill =

& Clear~

Editing

A v

2Y

Sort &
Filter

Something interesting has happened to the worksheet:

A B C D
1 Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar
4 New York ) 22,000 29,000 19,000
5 Los Angeles ! 42,000 39,000 43,000
6 London : 18,000 20,000 22,000
7 | Paris ) 35,000 26,000 31,000
8 Munich L 12,000 . 15,000 13,000
9 [Total |=Sum(Ba:a8) |

Excel has placed a marquee around the number range that
AutoSum has guessed you want to work with. The pattern of dots
that marks the boundary of the marquee is called the marching ants.

The marching ants surround all of the numbers in the column
above, up to the first blank cell or text cell (in this case, up to the

word Jan).

=SUM(B4:B8) is your first glimpse of an Excel Formula. Formulas
always begin with an equals sign. This formula is using the SUM
function to compute the Sum (or total) of the values in cells B4 to

BS.

4 Press the <Enter> key or click the AutoSum button once
more to display the total January sales:
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tip
Entering an AutoSum

using only the
keyboard

You can also execute an
AutoSum using the keyboard
shortcut:

<Cmd>+<Shift>+<T>

7

A B C D

3 Jan Feb Mar

4 New York 22,000 29,000 19,000
5 Los Angeles 42,000 39,000 43,000
6 London 18,000 20,000 22,000
7 | Paris 35,000 26,000 31,000
8 Munich 12,000 15,000 13,000
9 [Total 129,000

Type the word Total into cell E3 and press the <Enter> key
once.

The active cell moves down one row and is now in cell E4.

A 8 c D E

3 Jan Feb Mar Total

4 | New York 22,000 29,000 19,000 !
5 |Los Angeles 42,000 35,000 43,000

Use AutoSum to calculate sales for New York.

1. Click: Home—>Editing=> AutoSum.

This time AutoSum correctly guesses that you want to sum the
values to the left of cell E4:

k) C D E F
3  Jan Feb Mar Total
a| 22,000 29,000 19,000 | =sum(B4:08) |
5 42,000 39,000 43,000

2. Press the <Enter> key, or click the AutoSum button once more.

A B C D E
1 Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar Total
4 | New York 22,000 29,000 15,000 70,000
5 Los Angeles 42,000 35,000 43,000
6 London 18,000 20,000 22,000
7 | Paris 35,000 26,000 31,000
8 Munich 12,000 15,000 13,000
9 Total 129,000

Save your work as First Quarter Sales and Profit-3.

© 2019 The Smart Method® Ltd
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note

You can also delete
cell contents using the
mouse

Pressing the <Delete> key is the
fastest way to delete cell
contents.

You can also delete the contents
of a cell using the mouse. To do
this:

1. Right-click the cell.

2. Click Clear Contents from
the shortcut menu.

First Quarter Sales and
Profit-3

Lesson 2-4: Select a range of
cells and understand Smart
Tags

1

2

4

Open First Quarter Sales and Profit-3 from your sample files
folder (if it isn’t already open).

Observe the formula behind the value in cell B9.

Click once on cell B9 or move to it with the arrow keys on your
keyboard.

Look at the formula bar at the top of the screen. Notice that the cell
displays the value of a calculation and the formula bar shows the
formula used to calculate the value:

B9 . fx =SUM(BA4:B8)

o B C D
8 Munich 12,000 15, 13,000
9 |Total 129,000 | 128,000
10
1 Value Formula

Delete the contents of cell B9.
Press the <Delete> key on your keyboard.

Change the word Total in cell A9 to USA Sales and press
the <Tab> key once.

The cursor moves to cell B9.

8 | Munich
9 IUSA Sales

12,000

Select cells B4:B5 with your mouse.

When the mouse cursor is hovered over a selected cell, there are
three possible cursor shapes:

Cursor What it does

| =ﬂ= 1.6 | The white cross (Select) cursor appears when

Yot ® | you hover over the center of the active cell.
You can then click and drag to select a range of
cells.

1.6 The black cross (AutoFill) cursor appears

: when you hover over the bottom right-hand
corner of the active cell. You'll be covering
AutoFill later in this session.

The hand (Move) cursor appears when you
hover over one of the edges of the cell (but not
the bottom right corner).

| 1.6 ll||
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note

Selecting cells with
the keyboard

To select cells with the keyboard
hold down the <Shift> key and
then use the <Arrow> keys to
select the range needed.

note

Selecting a large
range of cells with the
<Shift>-click
technique

If you need to select a very large
range of cells it is sometimes
useful to use this technique:

1. Click the cell in the top left
corner of the required
range.

2. If necessary, use the scroll
bars to make the bottom
right corner of the required
range visible.

3. Hold down the <Shift> key.

4. Click in the bottom right
corner of the required
range.

i orl 64,000 | 128,0)
L3

0 Formula Omits Adjacent Cells
Update Formula to Include Cells
Help on this Error

Ignore Error
Edit in Formula Bar

Error Checking Options...

Beginners often have difficulty selecting cells and end up moving
them or AutoFilling them by mistake.

Position the mouse at the center of cell B4 so that you see the white
cross (Select) cursor. When you see the white cross, hold down the
left mouse button and drag down to cell BS. You have now
selected cells B4 and B5 (in Excel terminology you’d say that you
have selected the range B4:B5).

A B
3 Jan
4 |New York 22,000
5 |Los Angeles 42,000

Display total USA sales in cell B9.

Because you have selected only the cells containing USA sales
(cells B4:B5), AutoSum can be used to show the value of the
selected cells.

Click the AutoSum button [l to display the total value of the
selected cells.

USA sales are shown in cell B9.

4

[ 9 usasales 64,000 |

Notice the small green triangle at the top left of cell B9. This is
Excel’s way of saying: “I think you may have made a mistake”.
Inspect a potential error using a Smart Tag.
1. Click once on cell B9 to make it the active cell.
An Exclamation Mark icon appears E This is called a Smart
Tag.
2. Hover the mouse cursor over the Smart Tag.

A tip box pops up telling you what Excel thinks you may have
done wrong (see below). Of course, in this case, everything is
fine. The Smart Tag thinks that perhaps you didn’t want to
total just the USA sales — but the Smart Tag is mistaken!

USA Sale \l sa,oool 128,000

The formula in this cell refers to a range that
has additional numbers adjacent to it.

Examine the remedial actions suggested by the Smart Tag.

1. Hover the mouse cursor over the Smart Tag icon E‘
2. Click the drop-down arrow that appears.

A list of possible remedial actions is displayed. In this case you
can choose Ignore Error to remove the green triangle from the
corner of the cell.

Save your work as First Quarter Sales and Profit-4.

© 2019 The Smart Method® Ltd
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Lesson 2-5: Enter data into a
range and copy data across a
range

Now that you have mastered the technique of selecting cells, you can use
it to speed up data entry.

When you select a range of cells prior to entering data, Excel knows that
all data entered belongs in that range. Several key combinations are then
available to greatly speed up data entry.

1 Open a new workbook and save it as Data Range Test.
2 Select cells B2:D4.

You learned how to do this in: Lesson 2-4: Select a range of cells and
understand Smart Tags.

P B C D E

b wWwN =

3  Type: London.
The text appears in cell B2, the top left cell in the range selected.
4 Press the <Enter> key.
The cursor moves to cell B3 as it normally would.
5 Type: Paris followed by the <Enter> key.
The cursor moves to cell B4 as it normally would.
6 Type: New York followed by the <Enter> key.

This time something new happens. The cursor doesn’t move to cell
B5 as you might expect, but jumps to cell C2 instead.

A B c D E

London
Paris
New York

b WwWN =

7  Type: 150,000 followed by the <Enter> key.

The value appears in cell C2 and Excel moves down the column

again to cell C3.
A B C D E
1
2 London 150,000
3 Paris
4 New York
5
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note
Entering the % symbol

On most Mac keyboards, the %
symbol is entered by pressing:
<Shift>+<5>.

10

11

12
13

14

15

Press the <Enter> key without entering a value to leave C3
blank.

The cursor moves down the column to cell C4.
Type 225,000 followed by the <Enter> key.
The cursor jumps to cell D2.

Press <Shift>+<Enter> twice to change your mind about
leaving the value for Paris blank.

1. Press <Shift>+<Enter> to move backwards to the value for
New York.

2. Press <Shift>+<Enter> a second time and you are back to the

Paris cell.
A B C D E
1
2 London 150,000
3 Paris
4 New York 225,000
5

Type 180,000 followed by the <Tab> key.

<Tab>moves you across the range, to cell D3.

A B Cc D E
1
2 London 150,000
3 Paris 180,000
4 New York 225,000
5

You can now appreciate how to use the technique of <Enter>,
<Tab>, <Shift>+<Tab> and <Shift>+<Enter> to save a lot of time
when entering a whole table of data.

Select cells D2:D4.
Type 50% but don’t press the <Enter> or <Tab> keys.

The challenge this time is to place the same value into cells D3 and

D4 without having to type the value two more times.
Press <Cmd>+<Enter>.

The value is replicated into all of the other cells in the selected
range.

A B C D E
1
2 London 150,000 50%
3 Paris 180,000 50%
4 New York 225,000 50%
5

Click the Save button to save the Data Range Test
workbook.

© 2019 The Smart Method® Ltd
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tip
Keyboard shortcuts

You can also make text bold by
using the keyboard shortcut:

<Cmd>+<B>

In the same way, you can make
text italic using the shortcut:

<Cmd>+<I>

...and underlined using the
shortcut:

<Cmd>+<U>

First Quarter Sales and
Profit-4

Lesson 2-6: Select adjacent
and non-adjacent rows and
columns

1

2

Open First Quarter Sales and Profit-4 from your sample files
folder (if it isn’t already open).

Select all of column A.

Hover the mouse cursor over the letter A at the top of the column.
The column header lights up and the mouse cursor changes to a
black down arrow:

Al B8 C

1 ISaIes and Profit Report - First Quarter 2016

Click to select the entire column. The column becomes slightly
shaded and a green line surrounds all of the cells.

A B C D
Sales and Profit Report - First Quarter 2016

w N -

Jan Feb Mar
22,000 25,000

Click: Home—~>Font—>Bold to bold face the column.

4 |New York 15,000

Because the whole column was selected, all of the values become
bold faced.

A B C D

Sales and ProfitjReport - First Quarter 2016

Jan Feb Mar
22,000 29,000
42,000 39,000
18,000 20,000

15,000
43,000
22,000

New York

Los Angeles
6 |London

Vi b W N e

Click: Home—>Font->Bold once more to change the type in
column A back to normal.

Select all of row 4.

1. Hover the mouse cursor over the number on the left-hand side
of row 4. The number button lights up and the mouse cursor
changes to a black arrow pointing across the row:

3 Jan
= New York
5 Los Angeles

22,000
42,000

2. Click to select the row.
Select columns B and C.

Hover the mouse cursor over the letter at the top of column B until
you see the black down arrow. When you see the arrow, click and
drag to the right to select columns B and C.
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A B | C D
1 |Sales and Profit |Report - First Quarter 2016
2
3 Jan Feb Mar
4 |New York 22,000 25,000 15,000

Select rows 6 and 7.

1. Hover over the number at the left of row 6 until you see the
black arrow pointing across the row.

2. When you see the arrow, click and drag down to row 7 to
select both rows.

5 Los Angeles 42,000 39,000
6 |London 18,000 20,000
7 |Paris 35,000 26,000

Select columns A, B, C, D and E without dragging the
mouse.

Sometimes you will need to select a large number of adjacent
columns or rows. You could drag across them, but it is often easier
to use the following technique:

1. Select column A.
2. Hold down the <Shift> key.
3. Select column E.

Columns A to E are selected.

B W N e

el e e e e

Sales and Profit Report - First Quarter 2016

Jan Feb Mar Total

New York 22,000 25,000 15,000 70,000

Select rows 4 and 6.

Perhaps you need to perform an operation on two non-adjacent
rows. To select rows 4 and 6 you need to:

1. Select row 4.
2. Hold down the <Cmd> key on the keyboard.

3. Select row 6.

3 Jan Feb Mar

G:INewYott 22,000 29,000 15,000
5 | Los Angeles 42,000 35,000 43,000
6 [ondon ] 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000

© 2019 The Smart Method® Ltd
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note

Deselecting cells

Sometimes you might make a
mistake when selecting a range
of cells. This can be frustrating if
you need to select a complex
non-contiguous range, so
Microsoft have added the ability
to deselect cells in Excel 2019.

You can deselect a range of cells
by holding down the <Cmd>
key and either clicking the cells
you want to deselect or clicking
and dragging to deselect a range
of cells.

First Quarter Sales and
Profit-4

Lesson 2-7: Select non-
contiguous cell ranges and
view summary information

Non-contiguous is a very impressive word! It simply means a range of
cells that is split across two or more blocks of cells in different parts of the
worksheet.

Non-contiguous ranges can be selected using both the mouse and
keyboard. The keyboard method may seem a little involved at first but
you'll find it much faster once you have the hang of it.

1 Open First Quarter Sales and Profit-4 from your sample files
folder (if it isn’t already open).

2 Select the contiguous range B4:D8 with the keyboard.

When you need to select a contiguous range with the keyboard
here’s how it’s done:

1. Use the arrow keys on the keyboard to navigate to cell B4.
2. Hold down the <Shift> key on the keyboard

3. Still holding the <Shift> key down, use the arrow keys on the
keyboard to navigate to cell D8.

The contiguous range B4:D8 is selected.

A B C D E
1 Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar Total
4 |New York 22,000 29,000 19,000 70,000
5 |Los Angeles 42,000 39,000 43,000
6 |London 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
8 |Munich 12,000 15,000 13,000
9 USASales 64,000 128,000

3 Select the non-contiguous range B4:B8,D4:D8 using the
mouse.

1. Select the range B4:B8 using the mouse.

2. Hold down the <Cmd> key and select the range D4:D8 using
the mouse.

The non-contiguous range B4:B8,D4:D8 is selected:

A B C D E
1 Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar Total
4 |New York 22,000 29,000 19,000 70,000
5 |Los Angeles 42,000 39,000 43,000
6 |London 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
8 |Munich 12,000 15,000
9 USASales 64,000 128,000
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note

Where is the Fn key?

The Fn key may be in a different
place depending upon the
keyboard you are using.

On smaller keyboards, the Fn
button is usually in the lower
left corner, next to the Ctrl and
Cmd keys.

On larger keyboards, the Fn key
is on the right side of the
keyboard in the group of
buttons above the arrow keys.

note

If Fn+F8 doesn’t work

The F1-F12 keys at the top of
your keyboard are called
function keys. By default, these
are configured to perform
actions within macOS (OS X).

Holding the Fn key allows you
to override these actions and use
the standard functions of these
keys, enabling them to work
with the features of Excel and
other applications.

It’s possible to configure macOS
to allow these to work as
standard function keys by
default. If this is the case on
your Mac, you can just press F8
alone, without holding Fn.

Select the same non-contiguous range with the keyboard.

This is a little more involved than using the simple
<Shift>+<Arrow keys> method used earlier.

Here’s how it's done:
1. Use the arrow keys on the keyboard to navigate to cell B4.
2. Press <Fn>+<F8> (F8 is on the very top row of your keyboard).

See sidebar if you can’t find the Fn key or if something
unexpected happens when you do this.

3. Use the arrow keys to navigate to cell BS.
4. Press <Fn>+<Shift>+<F8>.

5. Use the arrow keys to navigate to cell D4.
6. Press <Fn>+<F8>.

7. Use the arrow keys to navigate to cell D8.
8. Press <Fn>+<Shift>+<F8>.

The non-contiguous range B4:B8,D4:D8 is selected:

A B G D E
1 Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar Total
4 |New York 22,000 29,000 70,000
5 |Los Angeles 42,000 39,000 43,000
6 |London 18,000 20,000 22,000
7 |Paris 35,000 26,000 31,000
8 |Munich 12,000 15,000 13,000
9 USA Sales 64,000 128,000

Obtain total sales figures for January and March using the
status bar.

The status bar contains summary information for the currently
selected range.

Look at the bottom right of your screen. You can see the average
sales and total sales (sum of sales) for January and March:

v Average

v Count
Numerical Count

v Minimum

v Maximum

v Sum

Average: 25,700 Count:10  Sum: 257,000

View the maximum and minimum sales for January and
March using the status bar.

Right-click the status bar and click Maximum and Minimum from
the pop-up menu (see sidebar).

The status bar now also displays maximum and minimum values.

Average: 25,700

Count: 10  Min: 12,000 Max: 43,000 Sum: 257,000

Close the workbook without saving.
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Lesson 2-8: AutoSelect a
range of cells

When data is arranged in a block (as it is in the Sales Report used in this
lesson) it is referred to as a Range.

You will often want to select a row or column of cells within a range, or
even the entire range.

You can select ranges by using any of the techniques covered so far but
this could be very time consuming if the range encompassed hundreds,
or even thousands, of rows and columns.

In this lesson you'll learn how to select range rows, range columns and
entire ranges with a few clicks of the mouse.

1 Open Sales Report from your sample files folder.

This report contains a single block of cells in the range A3 to E19.

A B Cc D E
1  Weekly Sales Report
2
3 |Invoice No Date Customer Country  Total
4 10918 10 March 2016 Bottom-Dollar Markets Canada 1,700.81
5 10917 10 March 2016 Romero y tomillo Spain 429.92
6 10926 10 March 2016 Ana Trujillo Emparedados y helados Mexico 604.42
7 10929 11 March 2016 Frankenversand Germany 1,380.33
8 10934 11 March 2016 Lehmanns Marktstand Germany 587.50
9 10939 11 March 2016 Magazzini Alimentari Riuniti Italy 749.05
10 10939 11 March 2016 Magazzini Alimentari Riuniti Italy - 749.05
11 10925 12 March 2016 Hanari Carnes Brazil 558.29
12 10944 12 March 2016 Bottom-Dollar Markets Canada 1,204.75
13 10923 12 March 2016 La maison d'Asie France 879.83
14 10937 13 March 2016 Cactus Comidas para llevar Argentina  757.64
15 10947 13 March 2016 B's Beverages UK 258.50
16 10933 13 March 2016 Island Trading UK 1,081.71
17 10938 14 March 2016 QUICK-Stop Germany 3,209.95
18 10949 14 March 2016 Bottom-Dollar Markets Canada 5,195.85
19 10945 14 March 2016 Morgenstern Gesundkost Germany 287.88
20 \
21 This report excludes sales to Asia and South Africa. Ra nge

2 Select all cells within the range to the right of cell A7.
1. Clickin cell A7 to make it the active cell.

2. Hover over the right-hand border of cell A7 until you see the
hand cursor shape.

7 | 1092@1 March 2016
8 10934 11 March 2016

3. When you see this cursor shape, hold down the <Shift> key
and double-click.

All cells to the right of A7, but within the range, are selected.

7 |

10929 11 March 2016 Frankenversand Germany 1,380.33 1

Sales Report

3 Select all cells within the range except the header row.
1. Clickin cell A4 to make it the active cell.
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note

Other ways to
AutoSelect a range

Using the keyboard

Here’s how you would select
the entire range in the Weekly
Sales Report (excluding the
header row) using the keyboard
method.

Make cell A4 the active cell by
navigating to it with the
<Arrow> keys.

1. Press: <Cmd>+<Shift>+
<DownArrow>

Cells A4:A19 are selected.

2. Press: <Cmd>+<Shift>+
<RightArrow>

The entire range (excluding
the header row) is selected.

Using shortcut keys

The shortcut keys method is the
fastest way to select the entire
range including the header row.

1. Click anywhere inside the
range.

2. Press: <Cmd>+<A>

The entire range (including
the header row) is selected.

From the Menu Bar

The Menu Bar method isn’t as
powerful as the other methods,
but does provide a way to select
the current range (described as
the region in the dialog).

Make sure that the active cell is
within the range.

1. Click:
&> Edit>Find>Go To...

The Go To dialog is
displayed.

2. Click Special...
The Go To Special dialog is
displayed.

3. Click the Current Region
option button and then
click the OK button.

Hover over the right-hand border of cell A4 until you see the
hand cursor shape.

4
5

| 1091@0

10917 10

When you see this cursor shape, hold down the <Shift> key
and double-click.

All cells to the right of cell A4, but within the range, are

selected.

Hover over the bottom border of the selected cells until you
see the hand cursor shape.

Date

Customer

10 March 2016 Bottom-Dollar Markets ..

10 March 2016 Romero y tomillo

el

When you see this cursor shape, hold down the <Shift> key
and double-click.

The entire range (except the header row) is selected.

|
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20

A B C D E

Weekly Sales Report

Invoice No Date Customer Country  Total
10918 10 March 2016 Bottom-Dollar Markets Canada 1,700.81
10917 10 March 2016 Romero y tomillo Spain 429.92
10926 10 March 2016 Ana Trujillo Emparedados y helados Mexico 604.42
10929 11 March 2016 Frankenversand Germany 1,380.33
10934 11 March 2016 Lehmanns Marktstand Germany 587.50
10939 11 March 2016 Magazzini Alimentari Riuniti Italy 749.05
10939 11 March 2016 Magazzini Alimentari Riuniti Italy - 749.05
10925 12 March 2016 Hanari Carnes Brazil 558.29
10944 12 March 2016 Bottom-Dollar Markets Canada 1,204.75
10923 12 March 2016 La maison d'Asie France 879.83
10937 13 March 2016 Cactus Comidas para llevar Argentina  757.64
10947 13 March 2016 B's Beverages UK 258.50
10933 13 March 2016 Island Trading UK 1,081.71
10938 14 March 2016 QUICK-Stop Germany 3,209.95
10949 14 March 2016 Bottom-Dollar Markets Canada 5,195.85
10945 14 March 2016 Morgenstern Gesundkost Germany 287.88

21 This report excludes sales to Asia and South Africa.

You can also use this technique to select cells to the left of the
active cell or above the active cell.

4 Close the workbook without saving.
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Lesson 2-9: Re-size rows and
columns

1

note

Why are you calling 2

the pound sign a
hash?

In the USA and Canada, the
hash symbol is called the
pound sign or the number
sign.

In different USA/Canada
regions the single symbol has
different names because it can
be used to denote a number (as
in contestant #5) or as a weight
(as in 3# of butter).

Throughout this book I will
refer to the # as a hash because
that is the term used in most
other English-speaking
countries.

note

Making several
columns or rows the
same size

Sometimes you will want to
make several columns exactly
the same width.

To do this, select the columns

that you want to resize and 4

then click and drag the
intersection of any of the
selected columns.

When the mouse button is
released, this will make each of
the selected columns exactly
the same width.

First Quarter Sales and
Profit-4

Open First Quarter Sales and Profit-4 from your sample files
folder (if it isn’t already open).

Notice that columns B, C, D and E are far too wide for their
contents. It would be useful to make them narrower to keep the
worksheet compact.

Re-size column B so that it is just wide enough to contain the
January sales figures.

Hover over the line separating the letters B and C until you see the
re-size cursor shape:

B + C

When you see this shape, keep the mouse still and then click and
drag to the left. Column B will re-size as you drag. Make it
narrower so that the values just fit in the column. Notice that the
column width is displayed in points and pixels as you drag.

A £
L16 v ¥ Width: 9.83 (64 pixels) .
A B C D
1 | Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar
4 New York 22,000 29,000 15,000

Re-size column B so that it is too narrow to contain the
January sales figures.

Notice that when the column isn’t wide enough to contain the
contents, hash signs are shown instead of values (if you're used to
hashes being called pound signs or number signs see the sidebar).

A B C D
1 Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar
4 New York L] 29,000 15,000

Automatically re-size column B so that it is a perfect fit for the
widest cell in the column.

1. Hover over the line separating the letters B and C until you see
the re-size cursor shape:

B + C
2. When you see this shape, double-click to automatically re-size
column B.

Automatically re-size every column in the worksheet in one
operation.
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note

Other ways to re-size
rows and columns

You can also re-size rows and
columns using the Ribbon.
Click: Home—>Cells>Format.

A drop-down menu appears.

1=l ) Z AutoSum ¥ A
- | X [l Fi- Z#

I Row Height...
AutoFit Row Height

= Column Width...
AutoFit Column Width
Default Width...

You can use the Row Height and
Column Width options to set the
row or column to a specific
number of centimeters or
inches (depending on your
Excel settings).

You can also use the AutoFit
Row Height and AutoFit Column
Width options to automatically
size the row or column (you
achieved this more efficiently
with a double-click in the
lesson).

Default Width... allows you to
set a new width for all columns,
but this will not affect columns
that have already been
manually resized.

You can also resize rows and
columns using the following
Menu Bar commands:

&->Format->Row->Height
&> Format—-> Column—>Width

1. Select every cell in the worksheet by clicking the select all
button in the top left corner of the worksheet (you can also do
this by clicking in any blank cell and then pressing
<Cmd>+<A>).

~/ A

1 Sales and Profit

2. Hover over the intersection of any two columns until you see
the re-size cursor shape and then double-click.
Every column is now perfectly sized.

Notice that AutoFit has done its job rather too well. Column A
is now wide enough to accommodate all of the text in cell Al.

A B
1 Sales and Profit Report - First Quarter 2016

Automatically re-size column A so that it is only wide enough
to contain the longest city name (Los Angeles).

1. Select cells A4:A9.
2. Click: Home—> Cells>Format—> AutoFit Column Width.

This time the column is automatically sized so that it is wide
enough to contain all of the text in the selected cells.

A B C D E
1 Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar Total
4 New York 22,000 29,000 15,000 70,000
5 Los Angeles 42,000 35,000 43,000

Notice that the text has spilled over from cell Al into the adjoining
columns B, C, D and E. This always happens when a cell contains
text and the adjacent cells are empty.

Manually size row 3 so that it is about twice as tall as the
other rows.

Do this in exactly the same way as you re-sized the columns but,
this time, hover between the intersection of rows 3 and 4 until you
see the re-size cursor shape, and then click and drag downwards.

1 Sales and Profit Report - First Quarter 2016
2 Height: 15.00 (15 pixels)
3| Jan TFeb Mar

4% NewYork 22,000 25,000 19,000

Auto-resize row 3 so that it is the same size as the other
rows again.

1. Hover over the line separatihe numbers 3 and 4 until you
see the re-size cursor shape.

2. When you see this shape, double-click to automatically re-size
row 3.

Close Excel without saving.
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Lesson 2-10: Use AutoSum to
sum a non-contiguous range

In: Lesson 2-7: Select non-contiguous cell ranges and view summary
information, you learned how to view the sum of January and March sales
using the status bar. But how can you put that value onto the worksheet?

Now that you have the hang of selecting non-contiguous ranges, you can
use this skill in conjunction with your AutoSum skills to create a formula
that will calculate the total of a non-contiguous range.

1 Open First Quarter Sales and Profit-4 from your sample files
folder (if it isn’t already open).

2 Enter the text Jan/Mar Sales in cell A10 and press the
<Tab> key.

The active cell moves to cell B10.

3 Re-size column A so that it is wide enough to contain the

text.

1. Hover over the line separating the letters A and B until you see
the re-size cursor shape:

A+ o8

2. When you see this shape, keep the mouse still and then click
and drag to the right. Column A will re-size as you drag. Make
it wider so that the words Jan/Mar Sales comfortably fit in the
column:

1
2
3
4
5
6
7
8
9

A B

Sales and Profit Report - First Quarter 2016

Jan
New York 22,000
Los Angeles 42,000
London 18,000
Paris 35,000
Munich 12,000
USA Sales 64,000

10 |san/Mar sales | 1

C D

Feb Mar
29,000 19,000
39,000 43,000
20,000 22,000
26,000 31,000
15,000 13,000

4 Use AutoSum to calculate the total sales for January and
March in cell B10.

1. Click Home%Editing% (the AutoSum button).

An AutoSum appears in cell B10, but it isn't anything like what
you want yet. AutoSum guesses that you want to sum the USA

Sales total.
8 Munich 12,000 15,000 13,000
9 Usasales 64,0001
10 | jan/Mar Sales | =SUM(ES)
First Quarter Sales and =
Profit-4 2. Select the range B4:B8 with the mouse.
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3. Hold down the <Cmd> key and select the range D4:D8 with

the mouse.

Notice that the non-contiguous range B4:B8,D4:D8 is shown in
the AutoSum’s formula:

i

1

2

3

4 New York

5 Los Angeles
6 London

7 Paris

8 Munich

9 USASales

11

Jan
22,000
42,000
18,000
35,000
12,000

N —
64,000

C

Feb . Mar
29,000| 19,000
395,000| 43,000
20,000| 22,000
26,000| 31,000
15,000 ! 13,000 3

10 [ san/Mar Sales [=5uM(84-25,04.05]

D

Sales and Profit Report - First Quarter 2016

Total
70,000

4. Press the <Enter> key or click the AutoSum button again to
show the sales for January and March in cell B10.

K

1

2

3

4 New York

5 Los Angeles
6 London

7 Paris

8 Munich

9 USASales

11

B

Jan
22,000
42,000
18,000
35,000
12,000
64,000

10 Jan/Mar Sales 257,000

C

Feb
29,000
39,000
20,000
26,000
15,000

D

Sales and Profit Report - First Quarter 2016

Mar
15,000
43,000
22,000
31,000
13,000

E

Total
70,000

5 Save your work as First Quarter Sales and Profit-5.

© 2019 The Smart Method® Ltd
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Z AutoSum | ¥

{ ¥ As.
2. Sum
Average
Count Numbers
Max
Min

More Functions...

First Quarter Sales and
Profit-5

Lesson 2-11: Use AutoSum to
quickly calculate averages

Excel’s AutoSum feature isn’t only restricted to addition. It is also able to
compute averages and maximum/minimum values.

In this lesson you'll use AutoSum to calculate the average sales for each
month.

1

2

Open First Quarter Sales and Profit-5 from your sample files
folder (if it isn’t already open).

Delete cells E3:E4.

Select cells E3 and E4 and press the <Delete> key on your
keyboard.

Type the word Average in cell E3 and press the <Enter>
key.

The cursor moves to cell E4.

A B C D E

3 Jan Feb Mar
4 | New York 22000 29,000 19,000

Average

Use AutoSum to create a formula that will show the average
New York sales in cell E4.

1. Click: Home->Editing=> AutoSum->Drop down arrow
(see sidebar).

A drop-down menu is displayed, showing all of the different
ways in which AutoSum can operate upon a range of cells.

2. Click Average.

Excel generates an AVERAGE function and inserts the cell
range B4:D4. This is exactly what you want:

E F

L Average
L:nVERAGE(Bﬁ :D4)

3. Press the <Enter> key or click the AutoSum button %] again to
see the average sales for New York:

3 Jan Feb Mar
4 New York 22,000 25,000 15,000

Average
23,333

Type the word: Maximum into cell F3 and then press the
<Enter> key.

Use AutoSum to create a formula in cell F4 that will show the
Maximum New York sales for this period.

1. Place an AutoSum in cell F4, but this time choose Max from the
drop-down menu.

This time you have a small problem. AutoSum is including the
average value (23,333) in the calculation.
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tip
Another way to bring back the
blue box showing a range is to

click the range in the Formula
Bar.

B C D E F
Jan Feb Mar Average ~Maximum

| 22000 29,000 19,000 23,333 |=MAX(B4EA)

2.  Select cells B4:D4 with the mouse

The marquee now covers the correct cells and the average
value in cell E4 is no longer included.

3 _Jan Feb Mar _Avctage Maximum
4 INewYork L 22,000 29,000 15,000 l 23,333|=MAxtE-‘. 3-'.[_

Notice that the MAX function is now working with the range
B4:D4.

3. Press the <Enter> key or click the AutoSum button £ once
more to see the maximum sales the New York office managed
during the first quarter of the year:

3 Jan Feb Mar Average Maximum
4 |New York 22,000 29,000 19,000 23,333 29,000

7 Change the words USA Sales in cell A9 back to Sales and

press the <Tab> key.

8 Press the <Fn>+<F2> keys on the keyboard (or double-click

cell B9) to bring back the marquee (shown as a blue box).

9 Adjust the marquee using click and drag so that all offices

are included in the Sales total.

Notice that there is a small blue square on each corner of the range.

These are called sizing handles.

1. Hover the mouse cursor over the bottom right (or bottom left)
sizing handle until the cursor shape changes to a double
headed arrow. It is really important that you see the double
headed arrow and not the hand or white cross.

2. When you see the double headed arrow, click and drag with
the mouse down to cell BS.

3. Release the mouse button.

4. Press the <Enter> key or click the AutoSum button %= again.

A B
3 Jan
4 | New York 22,000
5 Los Angeles 42,000
6 | London 18,000
7 | Paris 35,000
8 Munich 12,000
9 Sales 129,000
10 Jan/Mar Sales 257,000

10 Save your work as First Quarter Sales and Profit-6.
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Lesson 2-12: Create your own
formulas

The AutoSum tool is very useful for quickly inserting SUM(),
AVERAGE(), COUNT(), MAX() and MIN() formulas into cells. Many
Excel users never get any further with their formulas than this.

In this session you'll create your own formulas without the use of
AutoSum. You'll be amazed at how easy it is.

1 Open First Quarter Sales and Profit-6 from your sample files
folder (if it isn’t already open).

2 Select cells A10:B10 and press the <Delete> key once.
The previous contents of cells A10:B10 are removed.
3 Type the word Costs into cell A11 and Profit into cell A12.

4 Type the value 83,000 into cell B11 and press the <Enter>
key to move down to cell B12.

11 Costs 83,000

12 | Profit
u

5 Enter a formula into cell B12 to compute the profit made in
January.

1. Type: =B9-B11 into cell B12.
2. Press the <Enter> key.
The profit for January is displayed:

important
9 Sales 129,000
Formulas automatically =
recalculate whenever any of the e S
cells in the formula change. 121 ol getn
For example: If you were to 6 Enter the formula again using the mouse to select cell
change the Paris sales to 45,000 references.
this would cause cell B9 to re- . .
elleils b5 IBE00. The method that you have just used to enter the formula works just

fine but it isn’t the best method. Sooner or later you will make a
mistake. For example, you could easily type =B8-B11, resulting in
an incorrect answer.

Because B9 has changed this
would, in turn, cause the profit
to recalculate to 56,000.

To eliminate such errors, you should always select cell references
visually rather than simply typing them in. You can visually select
cells using either the mouse or the keyboard. First you'll use the
mouse method.

1. Click in cell B12 and press the <Delete> key on the keyboard to
clear the old formula.

Press the equals <=> key on the keyboard.
Click once on the value 129,000 in cell B9.
Press the minus <-> key on the keyboard.

Click once on the value 83,000 in cell B11.

First Quarter Sales and
Profit-6

S T i

Press the <Enter> key on the keyboard.
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4

*

/
%

important

Addition
Subtraction
Multiplication
Division
Percent

Exponentiation

The Excel Operators

Name Example

1+2
7-5
6*3
15/5
25%
472

If you followed the above steps carefully you will see that you
have created the same formula but with a much lower possibility
of making a mistake.

Enter the formula again using the visual keyboard technique.

The very best Excel experts hardly use the mouse. You waste
valuable seconds every time you reach for the mouse.

Here’s the expert technique of visual selection via keyboard:

1. Use the arrow keys to navigate to cell B12 and then press the
<Delete> key on the keyboard to clear the old formula.

2. Press the <=> key on the keyboard.

3. Press the <Up Arrow> key three times to move to cell B9.
4. Press the <-> key on the keyboard.

5. Press the <Up Arrow> key once to move to cell B11.

6. DPress the <Enter> key on the keyboard.

Type 10% Bonus into cell B13.

This employer is very generous and pays the staff ten percent of all
profits as an incentive bonus.

In cell A13 type the words: 10% Bonus and then press the <Tab>
key on the keyboard to move to cell B13.

Enter a formula that uses the multiplication operator.

The multiplication operator is not an X as you might expect but an
asterisk (*). The other Excel operators are shown in the sidebar.

You need to press <Shift>+<8> to enter an asterisk. If you are using
a full-size keyboard with a numeric keypad at the right-hand side
you can also use the numeric keypad’s <*> key.

Whichever key you use you'll still see an asterisk in the formula.

Use either the mouse selection technique or the visual keyboard
technique to enter the formula shown below into cell B13 and then
press the <Enter> key to see how much bonus was earned:

=B12*0.1
A B
11 | Costs 83,000
12 | Profit 1_46,000]
13 |10% Bonus  |=812°0.1 |

Note that multiplying a value by 0.1 calculates ten percent of the
value. If you progress to the Essential Skills course in this series,
you’ll learn more about calculating percentages in: Lesson 4-3:
Format numbers using built-in number formats.

11 Costs 83,000
12 Profit 46,000
13 10% Bonus 4,600

10 Save your work as First Quarter Sales and Profit-7.
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trivia Lesson 2-13: Create functions
The feature that Excel uses to USing FormUIa Autocomplete

help you out with function calls

first made an appearance in . " .
Visual Basic 5 back in 1996 and 1 Open First Quarter Sales and Profit-7 from your sample files

R s P folder (if it isn’t already open).
IntelliSense. The Excel 2
implementation is called

Formula AutoComplete.

Type the words USA Sales into cell A15 and European
Sales into cell A16.

In 1996 I was working in The text European Sales may have spilled over into column B if
Switzerland (as a programmer column A isn’t wide enough to contain it.

d analyst) developi ki- . s .
and analys) developing a ski 3 If necessary, re-size column A so that it is wide enough for

school management U
application. I was extremely the words European Sales to fit within the column.
impressed by how easy

) . You learned how to do this in: Lesson 2-9: Re-size rows and columns.
IntelliSense made my job. I

didn’t have to remember A
hundreds of function names _ :
any more. 15 USA Sales

16 European Sales

I was even slightly worried that

just about anybody could now 4 Click into cell B15 and type =S into the cell.
svrrc:)f;)m (but, of course, [ was Something amazing happens:

Recently I was in London being = |USAS""" [=_S|—l
driven by a Hackney cab driver 16 |European Sales | £ynctions

(Hackney cab drivers know 12
every shortcut and back street i SEC

in London). He was worried 19
that Satellite Navigation would
now mean that anybody could
become a London cabbie.

A list appears showing every function in the Excel function library
beginning with S. This feature is called Formula AutoComplete (if

AutoComplete didn’t display as expected see the facing-page
Of course, he really had sidebar).

nothing to worry about either!

You've already encountered the SUM(), AVERAGE() and MAX()
functions courtesy of AutoSum.

You may be pleased (or dismayed) to know that there are over 300

n Ot e functions in the Excel function library. The good news is that most

untrained Excel users only ever get to understand SUM() and
; !

Excel automatically AVERAGE()

adds closing brackets When you typed =S Excel listed all functions beginning with S.

to functions 5  Continue typing: =SU

If you type: Notice that the list now only shows functions beginning with SU

~SUM(B4:B5 'and loqk. .. there’s the SUM() function that you need, three down
in the list.

... and then press the <Enter>
key, Excel will automatically
add the closing bracket for you
resulting in: 6 Press the <Down Arrow> key to move the cursor over the
=SUM(B4:B5) SUM function.

You could simply click on it with the mouse, but let’s work like an
Excel pro and do it with the keyboard.

7 Complete the formula to display the syntax box.

Complete the formula by pressing the <Tab> key.
First Quarter Sales and

Profit-7 Alternatively, type M( to finish the formula manually.
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note

Enabling and
disabling
AutoComplete

As with so many other features,
Microsoft allows you to turn
this very useful feature off.

You’d never want to do this,
but you may work on a
machine that has had Formula
AutoComplete switched off
and you need to turn it on
again.

Click:
&->Excel>Preferences>
AutoComplete

...and make sure that the Use
AutoComplete box is checked.

note

The syntax box

The syntax box tells you which
arguments (sometimes called
parameters) the function needs.

SUM(number1, [number2], ...)

The first argument has no
square brackets, meaning that
you can’t leave it out.

The second argument (shown
in square brackets) is optional.

The third argument is an
ellipsis (a row of three dots).
This means that you could
continue with more arguments
such as [number3], [number4]
etc.

For such a simple function as
SUM() the syntax box is hardly
needed, but later you'll
encounter functions that
require several arguments and
then the syntax box will be
invaluable.

15 | USASales [=sump l

16 EuropeanSales  syumM(numbert, [number2), ...)
172 y T

Notice that a little box has appeared beneath the function. This box
displays the Syntax of the SUM function (see sidebar for more
information).

Select the cells that you need to sum (cells B4:B5) with the
mouse or keyboard.

If you want to be a real pro you should select them with the
keyboard. To do this:

1. Press the <Up Arrow> key repeatedly until you reach cell B4.

2. Hold down the <Shift> key and press the <Down Arrow> key
once to select cells B4:B5.

3. DPress the <Enter> key.
The total USA sales are displayed in cell B15.

A B

15 USA Sales ¥ 64,000

If you typed the formula in manually, you might notice that
Excel automatically added a closing bracket when you pressed
the <Enter> key (see sidebar facing page).

Use the same technique to create a SUM() function in cell
B16 to show the total European sales (cells B6:B8).

1. Click in cell B16.
2. Type=SU

3. Press the <Down Arrow> key to move the cursor over the SUM
function.

4. Press the <Tab> key to automatically enter the SUM function
into cell B16.

5. Select the range B6:B8.
6. Press the <Enter> key.

B16 . fx  =SUM(B6:B8)
A B C D E

15 USA Sales 64,000

16 |Europea g\ s |' 65,000 .I

17

The formula should now be: =SUM (B6:B8)

10 Save your work as First Quarter Sales and Profit-8.

© 2019 The Smart Method® Ltd
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note

If you don’t see the
AutoFill handle
somebody has
disabled AutoFill

It's almost certain that AutoFill
will be enabled on any
computer that you work on. It
is such a useful feature that you
wouldn’t want to disable it.

If you don’t see the AutoFill
handle (the black spot on the
bottom right hand corner of the
active cell) it’s because
somebody has switched
AutoFill off.

To bring it back, click:
&> Excel > Preferences> Edit

...and make sure that the Allow
fill handle and cell drag-and-drop
box is checked.

First Quarter Sales and
Profit-8

Lesson 2-14: Use AutofFill for
text and numeric series

1 Open First Quarter Sales and Profit-8 from your sample files
folder (if it isn’t already open).

2 Delete the text Feb and Mar from cells C3:D3.

Select cells C3:D3 and then press the <Delete> key on your
keyboard.

3 Make B3 the active cell

Click once inside cell B3. Notice that there is a green border around
the cell and a spot on the bottom right-hand corner. This is the
AutoFill handle. If you don’t see it, refer to the sidebar.

Autofill
[an 1] Handle

4 Hover over the AutoFill handle with your mouse until the
cursor shape changes to a black cross.

Many of my students have great difficulty with this when they try
it for the first time.

e You don't want the hand: @ — that would move the cell.

e  You don’t want the white cross: '%' — that would select the
cell.

e You want the black cross: ¥ — the AutoFill cursor.
Jan +|

5 When the black cross cursor is visible, hold down the mouse
button and drag your mouse to the right to AutoFill the other
months: Feb and Mar.

Jan | +

22,000 29,000 1nAnn
42,000 39,000 .Mar

Notice the tip that appears as you drag, previewing the month that
will appear in each cell.

When you release the mouse button, the name of each month
appears in cells C3 and D3.

B C D
3 [ Jan Feb Mar l

6 Type: Monday into cell A18 and AutoFill down to cell A24 to
show the days of the week.

(If you are not using an English language version of Excel you will
need to type Monday in your own language).
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10
11

12

13

14

15

In cell B18 type the number 1 and in cell B19 type the
number 2.

Select cells B18 and B19.

1
9P 2
AutoFill down to B24 to create sequential numbers:
A B
18 Monday 1
19 Tuesday 2
20 Wednesday 3

In cell C18 type 9 and in cell C19 type 18.

Select cells C18 and C19.
3
db 18
AutoFill down to B24 to create the nine times table.
A 8 C
18 Monday 1 9
19 Tuesday 2 18
20 'Wednesday 3 27

Use AutoFill to create sequential dates.

1. Type 01-Jan-16 into cell D18.

2. Type 02-Jan-16 into cell D19.

3. Select cells D18:D19.

4. AutoFill down to D24 to create sequential dates.
Use AutoFill to quickly copy text.

Sometimes you will want to duplicate the value from one cell into
many others to the right of, left of, beneath, or above the active cell.

When a cell containing text is the active cell and it isn’t defined as a
fill series (the built-in fill series are days of the week and months of
the year), AutoFill will simply duplicate the contents of the cell.

Type the text Adjusted into cell E18 and then AutoFill it down as
far as cell E24.

The same text is now shown in each of the cells:

A B C D E
18 Monday 1 9 01-Jan-16 Adjusted
19 Tuesday 2 18 02-Jan-16 Adjusted
20 Wednesday 3 27 03-Jan-16 Adjusted
21 Thursday 4 36 04-Jan-16 Adjusted
22 Friday 5 45 05-Jan-16 Adjusted
23 Saturday 6 54 06-Jan-16 Adjusted
24 Sunday 7 63 07-Jan-16 Adjusted

Save your work as First Quarter Sales and Profit-9.

© 2019 The Smart Method® Ltd
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First Quarter Sales and
Profit-9

Lesson 2-15: Use AutofFill to
adjust formulas

AutoFill can save you a lot of time when extending or copying text and
number sequences. But the story’s not over yet.

AutoFill’s ability to copy and adjust formulas is one of the most powerful
tools in Excel’s impressive toolbox.

1 Open First Quarter Sales and Profit-9 from your sample files
folder (if it isn’t already open).

2 Consider the formula in cell B9.

Click onto cell B9 and view the formula displayed in the formula
bar (the formula bar is at the top right of the screenshot below).

B9 . fx =Sum(Ba4:B8)
A B C D E F G
1 Sales and Profit Report - First Quarter 2016
: Formula Bar
3 Jan Feb Mar Average Maximum
4 New York 22,000 25,000 15,000 23,333 29,000
5 | Los Angeles 42,000 39,000 43,000
6 London 18,000 20,000 22,000
7 | Paris 35,000 26,000 31,000
8 Munich 12,000 15,000 13,000
9 |sales [129,0001

The formula is =SUM(B4:B8). AutoSum created it for you in:
Lesson 2-3: Use AutoSum to quickly calculate totals. The formula uses
the SUM() function to add together the values in the range B4:B8.

Think about the formula that would work in cell C9 (the total sales
for February). It would be: =SUM(C4:C8). Similarly the formula
that would work in cell D9 (the total sales for March) would be
=SUM(D4:D8).

As you move to the right, all that is needed is to increment the
letter for each cell reference in the formula and you'll get the right
answer every time.

AutoFill is very clever and realizes this. When you AutoFill a cell
containing a formula to the right, AutoFill increments the letters in
each cell reference.

Most of the time that is exactly what you want.

There’s also a way to fine-tune the way in which AutoFill adjusts
cell references, allowing you to implement some more advanced
AutoFill techniques. While this is beyond the scope of this Basic
Skills book, it is covered in-depth in the Essential Skills book in this
series (in Lesson 3 11: Understand absolute and relative cell references,
and Lesson 3 12: Understand mixed cell references).

3 AutoFill cell B9 to the right as far as cell D9.

You learned how to do this in: Lesson 2-14: Use AutoFill for text and
numeric series.
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E F

Average Maximum
23,333 25,000
41,333 43,000
20,000 22,000
30,667 35,000
13,333 15,000

You may see a row of hashes in cell C9 and/or D9. This is because
the value may be too wide to fit in the cell. If this is the case,
AutoFit the column using the skills learned in: Lesson 2-9: Re-size
rows and columns.

The correct answers for Feb and Mar sales are shown on the
worksheet. Click on the Feb total cell (C9) and look at the formula
in the formula bar.

c9 . fx  =SUM(C4:C8)
A 8 c D 3
1 | Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar Average
4 New York 22,000 29000 15000 23,333
5  Los Angeles 42,000 39,000 43,000
6 London 18,000 20,000 22,000
7 Paris 35000 26,000 31,000
8 Munich 12,000 15,000 13,000
9 |sales 129,000 [ 129,000 | 128,000

You can see that AutoFill has done its job perfectly, creating the
sum of the values in cells C4:C8. The five branches have sold
exactly the same amount in both January and February, but a little
less in March.

Consider the formula in cell E4.

Click onto cell E4 and view the formula displayed in the formula
bar.

E4 . fx =AVERAGE(B4:D4)
A 8 C D E

1 Sales and Profit Report - First Quarter 2016

2

3 Jan Feb Mar Average

4 |New York 22,000 29,000 19,000 23,333 |

5 Los Angeles 42,000 35,000 43,000

6 London 18,000 20,000 22,000

The formula is =AVERAGE(B4:D4). AutoSum created it for you in:
Lesson 2-11: Use AutoSum to quickly calculate averages.

Think about the formula that would work in cell E5 (the average
sales for Los Angeles). It would be: =AVERAGE(B5:D5). Similarly
the formula that would work in cell E6 (the average sales for
London) would be =AVERAGE(B6:D6).

As you move downward, all that is needed is to increment the
number for each cell reference in the formula. This is exactly what
AutoFill will do.

AutoFill cell E4 down to E8 to see the average sales for each
branch.

AutoFill cell F4 down to F8 to view the maximum sales for
each branch.

Save your work as First Quarter Sales and Profit-10.

© 2019 The Smart Method® Ltd
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First Quarter Sales and
Profit-10

Lesson 2-16: Use AutoFill
options
Sometimes AutoFill begins to misbehave and actually gets in the way of

efficient work by wrongly anticipating what you need.

1 Open First Quarter Sales and Profit-10 from your sample
files folder (If it isn’t already open).

2 Populate cells F18 to F24 with sequential dates beginning
with 1-Jan-16 using AutoFill.

1. In cell F18, type the date: 1-Jan-16
2. AutoFill cell F18 down as far as cell F24.

The cells are populated with sequential dates:

A B C D E F
18 Monday 1 9 01-Jan-16 Adjusted 01-Jan-16
19 Tuesday 2 18 02-Jan-16 Adjusted 02-Jan-16
20 Wednesday 3 27 03-Jan-16 Adjusted 03-Jan-16
21 Thursday 4 36 04-Jan-16 Adjusted 04-Jan-16
22 |Friday 5 45 05-Jan-16 Adjusted 05-Jan-16
23 Saturday 6 54 06-Jan-16 Adjusted 06-Jan-16
24 | Sunday 7 63 07-Jan-16 Adjusted 07-Jan-16

3 Populate cells G18 to G24 with the date 37-Mar-16 using the
AutoFill Smart Tag.

1. In cell G18 type the date: 31-Mar-16
2. AutoFill down as far as cell G24.

At some time, you'll need to add transaction dates to a
worksheet and will have four or five entries with the same
date.

AutoFill is perfect for eliminating the need to re-type the date
for each transaction, but its insistence upon incrementing the
date every time could be very frustrating.

Fortunately, you can change the default behavior.

3. Click the Auto Fill Options Smart Tag at the bottom right
corner of the filled cells.

05-Apr-16
06-Apr-16

F'

Copy Cells
v Fill Series
Fill Formatting Only
Fill Without Formatting
Fill Days
Fill Weekdays
Fill Months
Fill Years
Flash Fill

4. Click Copy Cells to tell AutoFill not to increment the date.
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4 Understand AutoFill options.

If you later progress to the Essential Skills book in this series, the
Fill Formatting option is covered in-depth in: Session Four: Making
Your Worksheets Look Professional.

Here’s what the other options will do:

Copy Cells  Fill Series  Fill Days Fill Weekdays Fill Months Fill Years
This is what The default | The date Because 15t April | Normally this would | The same
you just did. for dates that | increments 2016 was a show the same day calendar day
The first cell is include the by one day at | Friday, the number for each is shown for
copied to the day. a time. weekend days month. In this each
other cells. The date are omitted, and | example, there are subsequent
increments the series jumps | only 30 days in three | year.
by one day at from 1st April to | of the months so 30t
a time. 4% April. is shown instead of
31,
31-Mar-16 31-Mar-16 | 31-Mar-16 | 31-Mar-16 31-Mar-16 31-Mar-16
31-Mar-16 01-Apr-16 01-Apr-16 01-Apr-16 30-Apr-16 31-Mar-17
31-Mar-16 02-Apr-16 02-Apr-16 04-Apr-16 31-May-16 31-Mar-18
31-Mar-16 03-Apr-16 03-Apr-16 05-Apr-16 30-Jun-16 31-Mar-19
31-Mar-16 04-Apr-16 04-Apr-16 06-Apr-16 31-Jul-16 31-Mar-20
31-Mar-16 05-Apr-16 05-Apr-16 07-Apr-16 31-Aug-16 31-Mar-21
31-Mar-16 06-Apr-16 06-Apr-16 08-Apr-16 30-Sep-16 31-Mar-22
n ote You'll also notice the Flash Fill option. Flash Fill is a new feature in
Excel 2019 for Mac, and you'll look at it in depth later in this
AutoFill bug session.

You may encounter a bug that
takes you back to the Excel start
screen when you try to AutoFill
using the right-click menu.

This bug affects Excel version
15.37 and should be fixed in a

future update.

Copy Cells
Fill Series

Fill Days

Fill Months
Fill Years

Flash Fill
Series...

Fill Formatting Only
Fill Without Formatting

Fill Weekdays

5 Populate cells F18 to F24 with sequential dates using a right-
click AutoFill.

1. Click on cell F18 to make it the active cell.

2. AutoFill down to cell F24, but this time hold down the right

mouse button instead of the left mouse button.

When you release the mouse button, you are instantly
presented with the AutoFill options (see sidebar).

This method is preferred to the Smart Tag method because it is
faster (one click instead of two).

3. Click: Fill Series or Fill Days.

In this example Fill Series and Fill Days produce exactly the
same result.

6 Save your work as First Quarter Sales and Profit-11.

© 2019 The Smart Method® Ltd
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Lesson 2-17: Speed up your
AutoFills and create a custom
fill series

In this lesson you're going to learn some advanced AutoFill techniques
that will massively speed up your efficient use of the AutoFill feature.

1 Open First Quarter Sales and Profit-11 (if it isn’t already
open).

2 Use an AutoFill double-click to populate cells G19:G24 with
sequential dates.

1. Delete the contents of cells G18:G24.
2. Type: 31-Mar-16 into cell G18.

A B C D E F G
18 |Mondav 1 9 01-Jan-16 Adjusted Dl-Jan-lGl 31-Mar-16|
19 Tuesday 2 18 02-Jan-16 Adjusted 02-Jan-16
20 Wednesday 3 27 03-Jan-16 Adjusted 03-Jan-16
21 Thursday 4 36 04-Jan-16 Adjusted 04-Jan-16
22 Friday 5 45 05-Jan-16 Adjusted 05-Jan-16
23 | Saturday 6 54 06-Jan-16 Adjusted 06-Jan-16
24 Sunday 7 63 07-Jan-16 Adjusted 07-Jan-16

3. Double click the AutoFill handle to automatically fill cells
G19:G24.

Hover over the AutoFill handle (the black spot at the bottom
right hand corner of cell G18). When you are sure that you
have the correct black cross cursor shape, double click to
automatically fill down to the end of the range.

A B C D E F G
18 Monday 1 9 01-Jan-16 Adjusted 01-Jan-16 31-Mar-16
19 Tuesday 2 18 02-Jan-16 Adjusted 02-Jan-16 01-Apr-16
20 'Wednesday 3 27 03-Jan-16 Adjusted 03-Jan-16 02-Apr-16
21 Thursday 4 36 04-Jan-16 Adjusted 04-Jan-16 03-Apr-16
22 Friday 5 45 05-Jan-16 Adjusted 05-Jan-16 04-Apr-16
23 Saturday 6 54 06-Jan-16 Adjusted 06-Jan-16 05-Apr-16
24 Sunday 7 63 07-Jan-16 Adjusted 07-Jan-16 06-Apr-16

3 Create a custom list containing the values: North, South,
East and West.

1. Click: > Excel>Preferences—> Custom Lists.
The Custom Lists dialog appears.

2. Click in the List entries box and add four custom list entries:
North, South, East and West, pressing the <Enter> key
between each item.

First Quarter Sales and
Profit-11
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@] Custom Lists
< Show All Q
List entries: Custom lists:
North NEW LIST
South Mon, Tue, Wed, Thu, Fri, Sat, Sun
E\fa:; ‘{ Monday, Tuesday, W...y, Saturday, Sunday
Add Jan, Feb, Mar, Apr,...g, Sep, Oct, Nov, Dec

January, February,..November, December

Press Return to separate list entries.

Import list from cells: & Import

3. Click the Add button to add the new custom list.
4. Click the Close button to close the Custom Lists dialog.

4 Use the newly-created custom list.
Type North into any cell and AutoFill down.

As you AutoFill, the custom list entries appear in the worksheet.

North
South
East
West
North
South
East
West

5 Delete the North, South, East, West... cells from the
worksheet.

6 Save your work as First Quarter Sales and Profit-12.
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important

A synonym is a word you use
when you can’t spell the other one.

Baltasar Gracian
(Philsopher 1601-1658)

Excel uses different
terminology in various menus,
dialog boxes and task panes
that mean the same thing (in
the context of this lesson):

Series, Forecast and Trend mean
the same thing.

Growth and Exponential also
mean the same thing.

In this lesson I'll consistently
use the terminology Series and
Exponential.

note

Excel can calculate a
linear series when the
step values of cells
are not equal

Excel calculates a linear series
(AutoFill also calls this a fill
series) using this formula:

Start Value + Step Value

Sometimes you may need to
produce linear series values
from a series of numbers that
have different step values. For
example, consider this range:

A B
2 Value Step Value
3 1
4 21 11
5 2.9 0.8
6 4.1 2.3

In this case Excel will use a
more complex mathematical
operation (called the least-
squares algorithm) to determine
the correct step value to use. In
the above example, Excel
would calculate a step value of
1.01.

B i

Rabbit Population

Lesson 2-18: Understand
linear and exponential series

Linear series

In: Lesson 2-14: Use AutoFill for text and numeric series, you used AutoFill’s
Fill Series method to automatically create these numeric series:

A B C
18 Monday 1 9
19 Tuesday 2 18
20 |Wednesday 3 27

These are both examples of Linear series.

Imagine that you had originally selected cells B1:B2 before AutoFilling
column B:

B
1 S
2 18
3

To calculate a linear series Excel first identifies the step value. The linear
series in column B has a step value of nine (18-9=9).

When you use AutoFill to Fill Series, Excel adds the step value to the start
value (the number shown in the previous cell).

After you have AutoFilled down to cell B3, the value shown in cell B3
will thus be twenty-seven (18 (the start value) +9 (the step value) = 27)

This is an example of a very simple linear series. Excel is also able to
calculate a linear series even when the step values of the selected cells are
not equal (see sidebar).

Exponential (or Growth) series

An exponential series is calculated by multiplying (rather than adding) the
start value by the step value. This type of series is usually referred to as an
exponential (rather than linear) series. Excel also uses the term growth
series as a synonym for exponential series (see sidebar).

Here’s an example:

e A truly excellent restaurant opens in town. On the first day they only
have one customer but the customer is so delighted by the food,
service and value that the customer tells two friends.

e The next day the two friends eat there and the restaurant has two
diners.

e The two friends are also so pleased with their experience that they
each also tell two friends. On the third day the restaurant has four
diners.
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note

Here’s how you could have
used the Ribbon to complete
this lesson:

1. Enter the value 200 into cell
B4.

2. Select cells B4:B51.

3. Click: Home->Editing>
Fill->Series...

The Series dialog appears.

4. Enter the following values
into the Series dialog:

Series
Saries in: Type: Date unit:
Rows Linear
O Columns O Growth
Date
Trend AutoFill

Step value: 1.2

Stop value:

corce | (D

Note that the value: 1.2 is used
because an exponential
(growth) series multiplies each
start value by the step value.

trivia

According to an old legend, the
inventor of the game of Chess
presented his new game to a
powerful king. The king was so
pleased with the game that he

offered the inventor any
reasonable reward.

The inventor asked for one
grain of rice for the first square
on the chessboard, two for the
second, four for the third... and
so on for each square on the
chessboard.

The king thought the inventor
was foolish to ask for such a
simple gift. Much later he
found that there was not
enough rice in the entire world
to fulfil the inventor’s request.

With the Excel skills you have
learned in this lesson, you
should easily be able to model
the King’s dilemma and
discover exactly how many
grains of rice would have been
needed (about 18.5 Quintillion).

You can see that the restaurant owner might expect that this trend will
continue and that each day the number of diners will double (in Excel’s
terminology, the step value is 2). Eventually, of course, the restaurant will
become full and the trend will have to end (in Excel’s terminology the
number of seats in the restaurant is the stop value).

In this lesson you will model this type of exponential series.
1 Open Rabbit Population from your sample files folder.

2 If the rabbit population of an island increases at the rate of
20% per month, use an exponential progression to calculate
how a newly introduced community of 200 rabbits will grow in
four years.

1. Type the value: 200 into cell B4 to set the rabbit population at
the beginning of the period.

2. Type the value: 240 into cell B5 to set the rabbit population
after one month.

3. Select the range B4:B5.

A B C
Rabbit Population

1

2

3 Month Population
4 1 200
5

6

2 240
3

Hold down the right-click mouse button on the AutoFill
handle at the bottom-right of the selected range and drag
down to AutoFill to cell B51.

4. Click Growth Trend on the shortcut menu. Note that this is the
shortcut menu’s synonym for: Exponential Series.

Copy Cells

Fill Series

Fill Formatting Only
Fill Without Formatting

Linear Trend

Growth Trend S

Flash Fill
Series...

5. After four years (48 months) the 200 rabbits will have grown to
a population of a little over a million.

A B
49 46 731,452
50 47 877,743
51 48 1,053,291

3 Save your work as Rabbit Population-1.

© 2019 The Smart Method® Ltd
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note

You can also Flash
Fill more quickly by
using the AutoFill
handle

The AutoFill handle is the small
black dot on the bottom-right
corner of the active cell (or
range of cells).

Autofill
fn 1 Handle

In: Lesson 2-16: Use AutoFill
options, you learned that if you
right-click and drag the
AutoFill handle you are
presented with AutoFill options:

Copy Cells

Fill Series

Fill Formatting Only

Fill Without Formatting

Fill Days

Fill Weekdays
Fill Months
Fill Years

Flash Fill
Series...

You can use the Flash Fill item
on the AutoFill options list to
request a Flash Fill.

This will do the same as
clicking:

Home->Editing>Fill->Flash
Fill

You'll find that this method is
faster than using the Ribbon.

This method is also the
preferred way to provide Flash
Fill with more than one
example result for more
complex problems (you'll do
this in: Lesson 2-20: Use multiple
example Flash Fill to concatenate
text).

A e,
Phone Book-1

Lesson 2-19: Use Flash Fill to
split text

Here are two examples of international telephone numbers.

+44 (0)113-4960227 (a UK telephone number)
+356 (0)2138-3393 (a Maltese telephone number)

The country code (or international dialing code) is shown as a + symbol
followed by one or more numbers. The NDD (National Direct Dialing
prefix) is shown in brackets. This is the access code used to make a call
within the relevant country but is omitted when calling from outside the
country. The Area Code consists of the numbers after the closing bracket
but before the hyphen.

In this lesson, you'll use Flash Fill to split telephone numbers into the
Country Code, Area Code and Phone Number like this:

A B C D E

Country Phone
3 Company Telephone Code AreaCode Number
4 BooksAMillion +44 (0)113-4960227 +44 113 4960227
5 MalteseBooks +356(0)2138-3393  +356 2138 3393
6 | Bargain Bookstore +44 (0)115-4960498 +44 115 4960498

In Mac Excel versions prior to Excel 2019 you had to use some very
complex formulas to split this type of text. With the new Flash Fill feature,
you can achieve the same result in seconds.

1 Open Phone Book-1 from your sample files folder.

2 Extract the Country Code from the telephone number in
column B and place it into column C.

If you were to type +44 into cell C4, Excel would interpret it as a
positive number and display the result as 44 (without the plus
sign).

In order to signal to Excel that you want the plus sign to be
displayed, you will need to indicate that +44 should be regarded as
text rather than as a number.

You discovered the technique for doing this in: Lesson 2-1: Enter
text and numbers into a worksheet.

If an apostrophe is placed before a number, Excel will regard it as
text.

1. Type: “+44 into cell C4 (an apostrophe followed by +44).
2. DPress: <Enter>

3. Making sure that the active cell is in one of the cells that will be
Flash Filled (i.e. anywhere in the range C3:C18), click:

Home->Editing>Fill->Flash Fill
You can also find Flash Fill on the Data tab, under:
Data—>Data Tools—>Flash Fill
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note

The difference
between Flash Fill
and a formula-based
solution

There are two ways to solve the
problem posed in this lesson:

1. Use Flash Fill

This is the method used in this
lesson. Flash Fill provides a fast
and simple solution.

2. Use complex formulas

Only expert Excel users could
construct the complex formulas
required to split the telephone
numbers contained in the
sample file without the use of
Flash Fill.

In the Expert Skills book in this
series you will solve exactly the
same problem presented in this
lesson without Flash Fill.

Complex formulas are used
instead, to provide a formula-
based solution.

Advantage of a
formula-based
solution

The results of a Flash Fill do not
automatically update when the
source data changes.

This means that if you changed
the telephone number in
column B you would then need
to Flash Fill three times to
update columns C, D and E.

Formula results automatically
update whenever the source
cells change.

This means that if you changed
the telephone number in the
formula-based solution, the
Country Code, Area Code and
Phone Number would
automatically update.

Alternatively, you could also use the shortcut keys: <Ctrl>+<E>
to Flash Fill. <Cmd>+<E> will not have the same effect, as the
Mac version of Excel uses <Cmd>+<E> as the shortcut to center
a cell.

The country code is extracted into the remaining cells in

column C.
A B C
Country
3 Company Telephone Code
4 BooksAMillion +44 (0)113-4960227 +44
5 Maltese Books +356 (0)2138-3393 +356
6 Bargain Bookstore +44 (0)115-4960498 +44

Notice that Excel has placed a green triangle in the top-left
corner of each cell. Excel thinks you may have made an error
but, of course, the value is fine. If you want to remove the
green triangles, use the method you learned in: Lesson 2-4:
Select a range of cells and understand Smart Tags.

Extract the Area Code from the telephone number in column
B and place it into column D.

Use the same method as you did for the country code. The first
area code you need to type is: ‘113

Even though there is no plus sign, it is still useful to include the
apostrophe as it will prevent Excel from re-formatting numbers
(see next step for more on this).

Extract the Phone Number from the telephone number in
column B and place it into column E.

Use the same method as you did for the country code. The first
telephone number is: ‘4960227

In this case you must use a leading apostrophe to prevent Excel
from re-formatting large numbers. For example, the telephone
number: 20180948 would be displayed as 2E+07 if you didn’t
include the apostrophe.

The Country Code, Area Code and Phone Number are now extracted
for every international telephone number:

A B C D E
Country Phone
3 Company Telephone Code AreaCode Number
4 BooksAMillion +44 (0)113-4960227 +44 113 4960227
5 Maltese Books +356 (0)2138-3393 +356 2138 3393
6 | Bargain Bookstore +44 (0)115-4960498 +44 115 4960498

Save your work as Phone Book-2.
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note

Flash Fill doesn’t
understand
mathematics

Consider this problem:
A B
100 101
1120 1121

180
149

b W N =

You could be forgiven for
thinking that Flash Fill could
populate cells B3 and B4 with
the numbers 181 and 150. In
order to produce this result
Flash Fill would have to detect
a mathematical relationship
between the numbers in
columns A and B.

Because Flash Fill doesn’t
understand mathematics, it will
always see the problem as a
textual one and will produce
this result:

A B
1 100 101
2 1120 1121
3 180 181
4 149 141

Flash Fill has used the logic
“replace the last character
displayed in column A with 1”
and not “Add one to the value
displayed in column A”.

W~ -

Client Names-1

Lesson 2-20: Use multiple
example Flash Fill to
concatenate text

Understand concatenation

Here is an example of splitting text:

A B C

3 Name First Name Last Name
4 Jessica Sagan Jessica Sagan
5 Stephen Bell Stephen Bell

In the above example, the text: Jessica Sagan was split into two separate
words: Jessica and Sagan. You saw how to do this using Flash Fill in:
Lesson 2-19: Use Flash Fill to split text

Concatenation is exactly the opposite of splitting. The two separate
words Jessica and Sagan can be concatenated to produce the single word:
Jessica Sagan. This is an example of very simple concatenation.

In this lesson, you'll perform some very advanced concatenation using
Flash Fill.

1 Open Client Names-1 from your sample files folder.

This workbook contains a list of very inconsistently formatted
client names:

A B C D
3 Last Middle  First
4 Sagan Elizabeth Jessica
5 Bell p Stephen
6 jennings John

You want to clean up this data so that client names are consistently
formatted like this:

A B C D
|Last Middle First Formatted Name
|Sagan Elizabeth Jessica  Sagan, Jessica E.
|Bell p Stephen Bell, Stephen P.

O e N o n bW

|jennings John Jennings, John
|Simpson Jane Meryl Simpson, Meryl J.
|hawking Alfred  Hawking, Alfred
|Ashe m Lucille  Ashe, Lucille M.

For Flash Fill to automate this task you will need to tell Flash Fill
what is needed by providing more than one example.

2 Type: Formatted Name into cell D3 and bold face the text.
(Excel will probably bold-face the text automatically).

It is important that the header text in row 3 is bold faced.
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3
4
A B Cc D
3 Last Middle First Formatted Name
4 Sagan Elizabeth Jessica Sagan, JessicaE.
5 Bell p Stephen Bell, StephenT.
6 jennings John jennings, John O.
7 Simpson Jane Meryl  Simpson, Meryl E.
8 hawking Alfred  hawking, Alfred L.
9 Ashe m Lucille  Ashe, LucilleU.
o)
6
A B c D
3 Last Middle First Formatted Name
4 Sagan Elizabeth Jessica Sagan, JessicaE.
5 Baell p Stephen Bell, Stephen P.
6 jennings John
7 Simpson Jane Meryl  Simpson, Meryl J.
8 hawking Alfred
9 Ashe m Lucille Ashe, Lucille M.
7
A B Cc D
3 Last Middle First Formatted Name
4 Sagan Elizabeth Jessica Sagan, JessicaE.
5 |Bell p Stephen Bell, Stephen P.
6 jennings John Jennings, John
7 Simpson Jane Meryl  Simpson, Meryl J.
8 hawking Alfred  Hawking, Alfred
9 Ashe m Lucille  Ashe, Lucille M.
8

When Flash Fill sees different formatting in the first row the row is
assumed to be a header row. Flash Fill then excludes the value in
the header row from its logic, providing more reliable results.

Provide a single example result in cell D4.
Type: Sagan, Jessica E. into cell D4.

Flash Fill cells D5:D9 based upon the example result in cell
D4.

You learned how to do this in: Lesson 2-19: Use Flash Fill to split text.

Excel completes the task but the results are not what you wanted
(see sidebar).

With only one example, Flash Fill has completely misunderstood
the requirement.

Provide two example results in cells D4 and D5.
1. Delete the names in cells D5:D9.

2. Provide another example of the correct result (in cell D5).

A B C D
3 Last Middle First Formatted Name
4 Sagan Elizabeth Jessica Sagan, JessicaE.
5 Bell p Stephen Bell, Stephen P.
6 jennings John

Flash Fill cells D6:D9 based upon the example results in
cells D4 and D5.

1. Select cells D4:D9.
2. Click: Home->Editing->Fill->Flash Fill.
This time Flash Fill has done a better job (see sidebar).

Notice the two blank results (for John Jennings and Alfred
Hawking).

Flash Fill doesn’t yet understand how to treat clients without a
middle name. The blank spaces are Flash Fill’s way of asking
you for yet another example.

Provide another example result in cell D6.
1. Type: Jennings, John into cell D6.

2. Press the <Enter> key.

3. Select cells D4:D9.

4. Click: Home->Editing—>Fill->Flash Fill.

This time Flash Fill has completed the task successfully (see
sidebar).

Save your work as Client Names-2.

© 2019 The Smart Method® Ltd
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Flash Fill in Excel for
Windows

While Excel 2019 is the first
Mac version of Excel to include
Flash Fill, this feature has been
available in the Windows
version of Excel since Excel
2013.

The Windows version of Excel
also includes an automatic
Flash Fill feature, which
automatically tries to apply
Flash Fill features ‘as you type’.

—
Flash Fill Examples ]

T

Lesson 2-21: Use Flash Fill to
solve common problems

Flash Fill (introduced to the Mac version of Excel in Excel 2019) is one of
Excel’s most useful features. It isn’t possible to over-state how useful this
tool is. I find myself using Flash Fill almost every day to solve a huge
number of different problems.

This lesson gives examples of many everyday tasks that [ have found can
be quickly and simply completed using Flash Fill. I've also included all of
the examples in the sample file: Flash Fill Examples.

In the following examples, Flash Fill filled the shaded cells.

Split text

Full Name First Name Last Name
Jessica Elizabeth Sagan Jessica Sagan
Stephen Bell Stephen Bell

John Paul Jennings John Jennings

Extract initials from names

Name Initials
Jessica Elizabeth Sagan JES
Stephen Bell SB
John Paul Jennings JPJ
Remove title from names
Full Name Short Name
Miss Jessica Elizabeth Sagan [Jessica Sagan
Mr Stephen Bell Stephen Bell
Mr John Paul Jennings John Jennings

Name

Jessica Elizabeth Sagan
Stephen Bell

John Paul Jennings

Sort Name

Sagan, Jessica
Bell, Stephen

Jennings, John

Concatenate text

Add commas (a useful name format for alphabetical sorting)

|First Name Middle Name Last Name Full Name
|Jessica Elizabeth Sagan Jessica Elizabeth Sagan
|Stephen Bell Stephen Bell
|John Paul Jennings |John Paul Jennings
Concatenate text and insert extra text
First Name Middle Name LastName Full Name
Jessica Elizabeth Sagan First Name: Jessica, Last Name: Sagan
Stephen Bell First Name: Stephen, Last Name: Bell
John Paul Jennings First Name: John, Last Name: Jennings
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Change capitalization

Mixed Case

stephen Bell
john Paul jennings

jessica elizabeth sagan

Title Case

Jessica Elizabeth Sagan

Stephen Bell

John Paul Jennings

Extract the day, month or year from a date

In all the date-based examples note that the Date column is formatted as a
date. If you progress to the Essential Skills book in this series, you will
learn how to format cells as dates in: Session Four: Making Your Worksheets

Look Professional.

Date Day Date Month Date Year
19th January 2013 19| 19thJanuary 2013 January 19th January 2013 2013
Sth August 1967 5| 5th August 1967 August 5th August 1967 1967
20th September 1999 | 20| 20th September 1999 |September 20th September 1999| 1999

Extract the day/month from a date

Date
19th January 2013
5th August 1967

20th September 1999

Day/Month

19th January

5th August

20th September

Extract domain names from e-mail addresses

E-mail address

Jack@Nimble.com

Mary@QuiteContrary.com
Humpty@Dumpty.com

Domain

QuiteContrary.com

Dumpty.com

Nimble.com

Format telephone numbers

Name

Books A Million
Bargain Bookstore
Books for Less

Tel (unformatted) Tel (formatted)

1134960227
1154960498
1164960593

(113) 496-0227
(115) 496-0498
(116) 496-0593

© 2019 The Smart Method® Ltd

99



Learn Excel 2019 for Mac Basic Skills with The Smart Method

note Lesson 2-22: Use the zoom
Can my mouse be control

used to zoom?

Zooming is used to magnify or reduce the worksheet. If you have a lot of
rows in a worksheet and have good eyes, you might want to zoom out
sometimes to see more of the worksheet on one screen.

The first Apple mouse to
include a scroll wheel was the
Mighty Mouse, first released in

2005. If you are using an Apple 1 Open First Quarter Sales and Profit-12 from your sample
mouse from before 2005, you files folder

won'’t be able to zoom in and '

out using the mouse. 2 Zoom in and out of the worksheet using the mouse.

Apple’s most recent mouse (the The fastest way to zoom a worksheet is by using the mouse, if your

Magic Mouse) does not include

> mouse has this ability (see sidebar).
a scroll wheel, but instead

allows you to scroll by holding To zoom using the mouse, hold down the <Ctrl> key on the
your finger on the mouse’s keyboard and roll the mouse wheel to zoom in and out.
surface and then moving it in ) )

the direction that you wish to 3 Zoom in and out of a worksheet using the zoom control.
scroll.

The zoom control is at the bottom right of your screen.

Any other mouse that has a
scr(})lll wheel should allow you Click and drag on the zoom control slider to zoom in and out of

v meE A8 dhevem i s your worksheet. You can also zoom by clicking the plus and minus
lesson. You do not need to use buttons on either side of the Zoom control.
an Apple mouse.

Zoom Zoom in
note Out - Click and
If mouse zooming drag to .
doesn’t work zoom c“?k here to
You might find that mouse * d lspla.y the
zooming doesn’t work, even - + 100% < ZOOm dl al o g

though you have a Magic
Mouse or a mouse with a scroll 4 Use the Zoom dialog to make cells A3:D9 fill the screen.
wheel. This may be due to a

bug in Excel for Mac. 1. Select cells A3:D9.
Excel sometimes gets confused A B C D :
over whether you are trying to 2
scroll within the workbook or
trying to scroll through items in . ... ... . i
menus on the Ribbon, 4 |New York 22,000 29,000 19,000 | 23,333

) 5 |Los Angeles 42,000 39,000 43,000 41,333
If this happens to you, you 6 |London 18,000 20000 22,000| 20,000
Sho‘;lld b‘]"j sl tt‘: B thed 7 |Paris 35,000 26000 31,000| 30,667
probiem by quittng an 8 |Munich 12,000 15000 13,000| 13,333
restarting Excel.

9 |Sales 129,000 129,000 128,000 )

You saw how to do this in:
Lesson 1-5: Minimize, re-size, 2. Click on the right hand side of the zoom bar.
move and close the Excel window.

+

| Zoom level. Click to open the Zoom dialog box.

The Zoom dialog is displayed.
First Quarter Sales and &1 play

Profit-12 3. Select the Fit Selection option button.
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Session Two: Doing Useful Work with Excel

Zoom
note
. Zoom to:
The Zoom dialog can 200%
also be accessed " 150%
using the Menu Bar 125%
100%
You can also access the Zoom
dialog by clicking: 2
50%
&> View>Zoom... 25%
O Fit selection
Custom: 400 | %
Cance

4. Click the OK button.

The worksheet is zoomed so that the selected cells completely
fill the screen.

M & v~ J = il First Quarter Sales and Profit-12 Q.- ©-
Insert Page Layout Formulas Data Review View &+ Share ~
i X A . = o/ . B Conditional Formatting = 14=s1 ) }
'I—\ L H" : /0 & Format as Table - - Q
Paste pr Font Alignment  Number / CollStyles + Calls Editing
Clipboard Styles
Al . fx  sales and Profit Report - First Quarter 2016 v
A B C D E
3 Jan Feb Mar Average
4 New York 22,000 29,000 19,000 23,333
5 Los Angeles 42,000 39,000 43,000 41,333
6 London 18,000 20,000 22,000 20,000
7 Paris 35,000 26,000 31,000 30,667
8 Munich 12,000 15,000 13,000 13,333
9 Sales 129,000 129,000 128,000
4 » Sheet1 Sheat2 Sheetd = +
Ready 1T Elo @ - —— + 8%

5  Zoom back to 100% using the Ribbon.

You'll probably find the zoom bar to be the quickest and most
convenient way to zoom, but you can also zoom using the Ribbon.

Click: View—=>Zoom~—>Zoom to 100%.

Zoom 240% v

@, zoom to 100%

oM 1n0%

The screen is restored to normal size.
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Lesson 2-23: Print out a
worksheet

You aren’t going to explore every option for preparing and printing a
worksheet in this lesson. If you progress to the Essential Skills book in
this series, you'll find a whole session dedicated to more advanced
printing techniques in: Session Seven: Printing Your Work.

This lesson only aims to teach you the bare minimum skills you need to
put your work onto paper.

1 Open First Quarter Sales and Profit-12 from your sample
files folder (if it isn’t already open).

A B C D E F G
1 Sales and Profit Report - First Quarter 2016
2
3 Jan Feb Mar Average Maximum
4 New York 22,000 29,000 19,000 23,333 29,000
5 Los Angeles 42,000 35,000 43,000 41,333 43,000
6 London 18,000 20,000 22,000 20,000 22,000
7 | Paris 35,000 26,000 31,000 30,667 35,000
8 Munich 12,000 15,000 13,000 13,333 15,000
9 Sales 129,000 129,000 128,000
10
11 Costs 83,000
12 Profit 46,000
13 10% Bonus 4,600
14

15 |USA Sales ¥ 64,000
16 European Sales ” 65,000

17

18 Monday 1 9 01-Jan-16 Adjusted 01-Jan-16 31-Mar-16
19 Tuesday 2 18 02-Jan-16 Adjusted 02-Jan-16 01-Apr-16
20 Wednesday 3 27 03-lan-16 Adjusted 03-lan-16 02-Apr-16
21 | Thursday 4 36 04-Jan-16 Adjusted 04-Jan-16 03-Apr-16
22 | Friday S 45 05-Jan-16 Adjusted 05-Jan-16 04-Apr-16
23 Saturday 6 54 06-Jan-16 Adjusted 06-Jan-16 05-Apr-16
24 Sunday 7 63 07-Jan-16 Adjusted 07-Jan-16 06-Apr-16

2  Click: €>File>Print.

The Print dialog appears, showing a preview of how the document
will print. By default, a simplified version of the dialog is shown.

3 Click Show Details to show the complete Print dialog.

2, POF B | Show Details \

The complete dialog is shown, enabling you to access more
printing options.

If the complete dialog is already visible, the Show Details button
will be replaced by a Hide Details button.

First Quarter Sales and
Profit-12
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Preview of how the page

will look when printed

Select Printer

10f1

A

Move to a different page

Hide Details

2, poF B3

Print
Printer: hp LaserJet 2420 UPD PCL 6 E
Presets: Default Settings E
Copies: 1
Pages: © All
From: 1 to: 1
Paper Size: A4 210 by 297 mm
Orientation: 'i Te
Excel E
Collate pages
Print: Active Sheets
Margins: Normal Margins
Scale to fit:
Print Options

Cancel

Send the worksheet to the printer

F

Print the worksheet.

Click the Print button:

The page is printed on the selected printer.

© 2019 The Smart Method® Ltd
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Session 2: Exercise

1 Open a new blank workbook.

2 Use AutoFill to put the three months Jan, Feb, and Mar into cells A4:Aé6.

3 Using only the keyboard, add the following data:

1
2
3
4
5
6
7

A B

Profit Analysis

Jan
Feb
Mar
Total

London
2,500
2,200
2,100

C

Paris
3,100
2,700
2,600

D

New York
2,300
2,600
2,800

Average

4 Use AutoSum to compute London’s total profit for Jan/Feb/Mar in cell B7.

5 Use AutoSum to compute the average January profit in cell E4.

6 Use AutoFill to extend the London total in cell B7 to the Paris and New York totals in cells C7 and

D7.

7 Use AutoFill to extend the January average profit in cell E4 to the February and March average
profits in cells E5 and E6.

8 Select all of column A and all of column E (at the same time) and bold face the values in them.

9 Select rows 3 and row 7 (at the same time) and bold face the values in them.

1
2
3
4
5
6
7

A B

Profit Analysis

Jan
Feb
Mar
Total

London
2,500
2,200
2,100
6,800

C

Paris
3,100
2,700
2,600
8,400

D

New York
2,300
2,600
2,800
7,700

E

Average
2,633
2,500
2,500

10 Select cells B4:B6 and cells D4:D6 at the same time and then read the total London and New York
sales figure for Jan, Feb and March from the summary information displayed on the status bar.

11 Select cells B4:D6 and zoom the selection so that these cells fill the screen.

12 Save your work as Exercise2-End.

If you need help
slide the page to
the left

© 2018 The Smart Method® Ltd
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Session 2: Exercise answers

These are the questions that students find the most difficult to answer:

Q10 Q8 Q4 Q2

1. Hover over the center of | 1. Click on the column 1. Click in cell B7. 1. Type Jan into cell
cell B4 so that you see the | A header. 2 Click: A4 and press the
white cross cursor shape. ) ’ <Enter> key.

— ,G ;) B ey
I - g Home~>Editing>
# z’sml v IProﬁt Ana‘ys_ls AutoSum g 2 Cllck Cell A4: once

to make it the active

2. Click and drag down to | 2- Hold down the T Autosum * cell.
cell B6. <Cmd> key. K 7 ? v

3. Click on the col . Oy Sacts 3. Hover the mouse
3. Hold down the <Cmd> h. dlC on the column @ Clear v Filter cursor over the
key. cacer: Editing bottom right corner
4. Hover over cell D4 until | 4- Click: 3. Press the <Enter> key. of the cell until you
you see the white cross Home->Font>Bold see the black cross
cursor shape. This was covered in: cursor shape.

Lesson 2-3: Use AutoSum

: Calibri (Body) + 12 |
5. Click and drag down to il to quickly calculate totals. 'Jan__i_
cell Dé.

BIE!_!

6. Look at the status bar at R Font 4. Click and drag
the bottom right of the down to cell Aé6.
screen. This was covered ir‘1: This was covered in:
This was covered in: Lesson Lesson 2-6: .Select adjacent Lesson 2-14: Use

2-7: Select non-contiguous and non-adjacent rows AutoFill for text and
cell ranges and view and columns. numeric series.

summary information.

If you have difficulty with the other questions, here are the lessons that cover the relevant skills:
Refer to: Lesson 1-2: Start Excel and open a new blank workbook.

Refer to: Lesson 2-1: Enter text and numbers into a worksheet.

Refer to: Lesson 2-3: Use AutoSum to quickly calculate totals.

Refer to: Lesson 2-15: Use AutoFill to adjust formulas.

Refer to: Lesson 2-15: Use AutoFill to adjust formulas.

Refer to: Lesson 2-6: Select adjacent and non-adjacent rows and columns.

Refer to: Lesson 2-22: Use the zoom control.

= 2 O N O 01 W -

N -

Refer to: Lesson 1-8: Save a workbook to a local file.
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Index

alt key, 28
apple
mouse, 18
arrange all, 60
Autocomplete
formula entry using, 82
AutoFill
custom fill series, creating, 90
date series, examples of, 88
formulas, using to adjust, 86
smart tag options, using, 88
text and numeric series, creating with, 84
AutoFit rows and columns, 75
automatic updates
applying, 22
switching on and off, 22
AutoSum, 62
AVERAGE functions, creating with, 78
MAX functions, creating with, 78
SUM a non contiguous range with, 76
AVERAGE function, 78

backstage view, 44
binary workbook format, 34

c_

cancel button, 58
cells
active cell, 72
deleting, 78
entering text into, 58
entering values into, 58
selecting a range of, 65
selecting all in a worksheet, 75
check box, 42
close button, 26
columns
making several the same size, 75
resizing automatically, 74
selecting, 68
selecting non contiguous, 68
width of, manually changing, 75
confirm button, 58

currency

prefixes, 59
cursor shapes, explained, 65
custom lists, 90

documents. See also files
organization of, 36
pinning, 36
downloading the sample files, 11, 30
drop-down list, 42

editing cell contents, 58

Excel 97-2003 workbook format, 34
Excel workbook file format, 32, 34
exponential. See series

F1-F12 keys, 70

files. See also workbooks; documents
formats supported, 32, 34
opening with earlier Excel versions, 34
organization of, 36

fill. See AutoFill

flash fill
autofill handle, using to apply, 94
examples, 98
formula based solution, compared to, 95
manual, use of, 94
multiple examples, use of, 96
numbers, working with, 96
telephone numbers, formatting with, 94
using to solve common problems, 98

fn key, 70

formula bar
explanation of, 64
graphic showing location of, 32
showing and hiding, 48

formulas
Autocomplete, creating with, 82
AutoFill, adjusting with, 86
AVERAGE function, creating using AutoSum,

78

F2 key to display range addressed by, 79
formula bar, viewing in, 64



MAX function, creating using AutoSum, 78
mouse selection, creating with, 80
multiplication operator (*) using in, 81
SUM function, creating using AutoSum, 62
syntax box, understanding, 82
visual keyboard technique, creating with, 81
fractions, entering into cells, 59
full screen view, 28
functions
AVERAGE, 78
MAX, 78
SUM, 62,76

gallery, 42
goto special, 73
growth. See series

help system
execute command, using to, 50
searching, 50

keyboard
alt key, 28
F1-F12 keys, 70
fn key, 70
option key, 28
keyboard shortcuts
AutoSelect a range, 73
AutoSum, 62
bold, 68
close, 26
cycle through worksheets, 39
flash fill, 95
full screen view, 28
italic, 68
mission control, 60
quit, 26
Ribbon, show/hide, 40
save, 32
save as, 32
select every cell in a worksheet, 74
underline, 68
workbook, create new, 60

macro enabled workbook format, 34

magic mouse, 18
Magic Mouse, 100
marching ants, 62
marquee, 62
MAX function, creating using AutoSum, 78
menus
shortcut (contextual), 18
standard, 42
microsoft autoupdate, 22
mighty mouse, 18
minimize button, 26
mouse
configuring, 18
right clicking, 18
scroll wheel, 100
zooming with, 100
moving
the Excel window, 26
multiplication operator (¥), 81

name box, 30

negative numbers, entering into cells, 59
normal view, 46

number sign (#), 74

office insider program, 22
office theme, changing, 24
office version

checking Excel version, 22
OneDrive

save a workbook to, 32
operating system

apple OS X, 11

checking version of, 11
option key, 28
organizing

excel files, 36

sample files folder, 30
OS X. See operating system

page layout view, 46
PDF, workbook format, 35
pound sign (#), 74
printing
previewing on screen, 44, 46



quick access toolbar
adding commands to, 44
adding separators to, 44
deleting commands from, 44
quit excel, 26
quotations
Aristotle, 42
Baltasar Gracian, 92
Confucius, 5
Euripides, 17
Robert Collier, 26
Winston Churchill, 4

ranges
AutoSelect , selecting automatically with, 72
copying data across, 66
entering data into, 66
non contiguous, selecting, 70
select all button, to select a range containing
every cell in a worksheet, 75
selecting, 64
selecting visually for formulas with the mouse,
80
restore down button, 26
Ribbon
benefits of wide screen with, 40
command groups on, 42
contextual tabs, explanation of, 41
controls on, 42
font panel controls, explanation of, 41
overview, 40
showing and hiding (minimizing), 41, 48
TOWS
making several the same size, 75
manually setting height of, 75
resizing automatically, 74
selecting, 68
selecting non contiguous, 68

sample files
downloading, 11, 30
organizing folder, 30

save, 32, 34

selecting cells, 64

series
dialog, 92
exponential, 92

growth, 92
linear, 92
start value, 92
step value, 92
stop value, 92
smart tag
explained, 64
options, 88
split button, 42
start Excel, 20
SUM function
creating manually using formula
AutoComplete, 82
creating using AutoSum, 62
switch windows, 60

tabs. See worksheets
telephone numbers, formatting with flash fill, 94
templates

using, 20
the smart method

learning by participation, 5

two facing pages rule, 4
themes. See also office theme
title bar, 60
trend. See also series

linear and exponential, 92
trend line. See charts

values
currency prefixes, using with, 59
entering into cells, 58
fractions, entering into cells, 59
negative numbers, entering into cells, 59
version
checking Excel version, 11

windows

arrange all, using to automatically size, 60

closing, 26

maximizing, 28

minimizing, 26

moving, 26

resizing, 26

restoring, 26

switching to view a different workbook, 60
workbooks. See also files



changing default number of worksheets in, 38 deleting, 38

creating new, 60 maximum number of rows and columns in, 30
opening, 30 navigating, 30, 38

saving, 32, 34 renaming, 38

switching between open workbooks, 60 tab colors, changing, 39

viewing two at the same time, 60
views, 46 z |

worksheets
zoom button, 26, 28

adding, 38 o
changing default number of, 38 zoom control,

chart worksheets, explanation of, 38



Moving to the next level

Learn

Excel 201 9 for. Mac

Essential Skills
With The Smart Meth

The next book/e-book in this series (Essential
Skills) builds upon the basic skills you’ve
already learned.

When you have completed this book/e-book you will have
excellent Excel skills, good enough to impress any employer,
and your Excel skills will be better than most office workers
(even those with many years of experience).

You'll be able to create beautifully laid-out worksheets that
will really impress and will have completely mastered all of
Excel’s charting features.

The paper printed book is always in stock at Amazon.

The e-book is also published in unlocked, printable PDF
format (just like this basic-skills e-book) and is only available
from: https://thesmartmethod.com (this is the publisher’s
own web site).

Learn

Excel 201 9 for Mac
Expert Skills
With The Smart Met

The last book in the series (Expert Skills)
covers only the most advanced Excel features.

This book will give you advanced Excel skills that are rarely
mastered by the average user. By the end of the book you'll
be a true Excel expert, able to use all of the power available
from the world’s most powerful business tool.

Your Excel skills will be greater and broader than almost all
other Excel users in the workplace.

The paper printed book is always in stock at Amazon.

The e-book is published in unlocked, printable PDF format
(just like this basic-skills e-book) and is only available from:
https://thesmartmethod.com (this is the publisher’s own web
site).
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Test Your Excel skills

Challenges are graded to
Basic, Essential and Expert level

Excel Challenges

Our Excel online challenges are a little like the exercises at the
end of each session in this book. Unlike the exercises, the
online challenges will test the application of many skills
(covered in different sessions in the book).

We began trialling challenges in July 2018 and (at time of
writing in January 2019) we have published three challenges.
By the time you read this book we may have produced more.

Access the challenges online at:

https://thesmartmethod.com/excel-challenges/




Use your new Excel skills to teach your
own classroom courses

If you progress to the Essential Skills book in this series you will have excellent Excel skills and if you the
further progress to the Expert Skills book, you'll be a true Excel expert and will be able to teach Excel skills at
all levels. There is a huge (and often unsatisfied) demand, everywhere in the world, for Excel training.

The Basic Skills, Essential Skills and Expert Skills books are available for all Excel versions in common use
(Excel 2007, 2010, 2013, 2016, 2019 and 365 for Windows along with Excel 2016 & 2019 for Apple Mac). You
can use the books as courseware during your classes and then give each student a copy of the book to take
home as reference material when the course is over. For larger (100+) book orders we can customize your
books by adding your own cover design and logo and editing content as required.
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You can quote the ISBN numbers shown above to any book retailer or wholesaler. All major distributors (in
every country of the world) have our books in stock for immediate delivery.

Place a direct order for 5+ books for wholesale prices and free delivery worldwide

To place a publisher-direct order you only need to order five books or more (of the same title). To view
wholesale prices, go to this web page: https://thesmartmethod.com/wholesale-printed-books




